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Chapter 1

OVERVIEW AND INSTALLATION

The paperless workflow can be a reality for your firm with CCH ProSystem fx Scan. Scan generates
bookmarked PDF files from scanned client documents. These files can then be stored in

CCH® ProSystem x® Document, CCH Axcess™ Document, CCH® ProSystem ® Document (On-
Premise) or any other Microsoft® Windows®-based document management system that includes the
ability to access PDF files. All the information needed to prepare tax returns is available in a digital
form and can be stored in your document management system.

If your firm uses CCH® ProSystem fx® Tax, CCH® Global fx Tax, or CCH Axcess™ Tax, Scan can
also extract data from the PDF files and flow it into client tax returns, dramatically reducing the
amount of manual data entry that is required.

What Scan Does

Scanning a document creates an image of the document. Text in the document is captured as part of
the picture. To make this text editable, Scan uses a process known as “optical character recognition”
(OCR). During OCR processing, the system compares individual elements in an image against a
library of characters. When the system finds a matching character, the image element is associated
with the matching character.

After completing OCR processing, Scan compares the text in the scanned document against template
tax forms in the Scan catalog. Scan classifies individual documents in a Scan job by matching
keywords in the scanned document with corresponding templates. When Scan creates a PDF file of
the scanned document, it also creates bookmarks in the PDF file that identify these forms.

The conversion of scanned text into editable text makes it possible for Scan to extract data from the
scanned tax form. If your firm uses Tax, this extracted data can be imported into client tax returns.

Scan Processing Overview

The quality of the image files submitted to Scan can affect the accuracy of OCR conversion. For this
reason, the recommended workflow for Scan includes several preparatory steps that can improve the
quality of images generated by scanning. These steps are not mandatory, but will give you the best
possible results from OCR processing.

Chapter 1 - Overview and Installation « 1



Note: This workflow assumes that Scan has already been installed and configured. See
Installing Scan Administrator on page 7 for installation instructions. For information about
configuring Scan, see Configuring Scan on page 12.

The Scan Workflow

— |=
O oo o -
— Archive
— @_‘ : — P File
o oo o
Source
Documents Scanner Image file Scan Bookmarked
PDF File

The basic workflow for using Scan is as follows:

1. Prepare source documents for scanning. The documents should be checked for staples,
folded corners, or other items that might interfere with getting a clear image of the document.
You should also sort and organize documents as part of this step. For more information, see
Preparing Documents for Scanning on page 29.

2. Printand insert cover pages and target sheets, if needed. Cover pages and target sheets
are special pages with bar codes on them. They are printed from Scan, and then scanned along
with the client documents. Scan reads the bar codes, and uses the information encoded in them
to categorize and bookmark the documents. For more information, see About Cover Pages and
Target Sheets on page 29.

3. Configure your scanner. The recommended scanner settings produce a high-quality image
that will produce the best OCR results. See Scanner Settings on page 84 for more information.

4. Scan the documents. Tips on getting the best results from scanning are included in Scanning
Tips on page 85.

5. Submit the image files to Scan for processing. From Scan Workstation, you can use a tool
called the Import Assistant to send scanned images for processing. See Importing Files for
Scan Processing with the Import Assistant on page 36 for more information.

When Scan detects a file that has been submitted for processing, it checks for and corrects
problems that might interfere with OCR conversion, such as skewed pages, upside-down pages,
and excessive speckling. It splits the scanned images into individual documents, and then
performs the tasks described in What Scan Does on the previous page.

6. Monitor the progress of scan processing in Scan Workstation. In Scan Workstation, you
can see the progress of each job in relation to the other jobs that are also being processed. See
Using Scan Workstation on page 27 for more information.

7. Validate the data converted through OCR processing. Scan does not require extracted
data to be validated. Your firm should set its own standards for when validation should occur.
See Validation Overview on page 40 for more information.
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8.

Note: You do not need Tax on your workstation to validate extracted data. Validation can
be performed on any computer running Scan Workstation.

Use AutoFlow Wizard to send extracted data to a client tax return. This step is optional.
To export data to a tax return, you must have Tax installed, and you must have access rights for
the client’s returns. See Chapter 5 - Integrating with Other Wolters Kluwer Products on page
48 for more information on using AutoFlow Wizard.

Scan Components

Scan is a collection of services that work together to process your scanned documents. The services
are accessible through two major components:

Scan Administrator is the center of Scan processing. When scans are submitted for
processing, Scan Administrator retrieves and optimizes them, then converts them into editable
text with OCR. Finally, Scan generates the bookmarked PDF files.

Scan Administrator is also where firm-level Scan options are configured. For this reason, only
staff members with system administrator privileges have access to Scan Administrator. See
Chapter 2 - Administering Scan on page 11 for details about the administrative tasks
associated with Scan.

Scan Workstation is the component that most staff members will use on a daily basis. Some
of the tasks that you can perform in Scan Workstation include:

= Generating cover pages and target sheets for Scan jobs

= Uploading files to be submitted to Wolters Kluwer for review

®  Submitting jobs for processing

= Monitoring documents as they are processed by Scan

= Checking to see if you have the latest Catalog update installed
®= Validating the accuracy of extracted data

®* Flowing extracted data into Tax

Scan is also packaged with CCH® ProSystem x® PDFlyer, a utility that allows you to perform
advanced manipulation of PDF files. Some tasks you can perform with PDFlyer include:

Inserting target sheets for easier digital file management before processing the file with Scan
Exporting PDF files to multi-page TIFF files
Managing and manipulating bookmarks in the PDF file using multiple bookmark tools

Using a basic calculator and a 10-key calculator that produce an electronic tape which can be
placed on the PDF file

Navigating through and marking up the PDF file with the use of connectors and tickmarks

Creating user stamps using your own images
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System Requirements for Scan Administrator

Scan Administrator is normally installed on a server, but it can be installed on a dedicated workstation
that meets the system requirements. You can store the Import, Archive, and Export folders anywhere
on your network or on a workstation that you select, as long as the folders are shared, with write
access granted to all the computers where Scan Administrator and Scan Workstation are installed.

Component Minimum Recommended
Processor Multi-Core Processor Multi-Core Processor
RAM 4GB 8 GB
. 10 GB for program files 10 GB for program files
Disk Space i i
10 GB for temporary data files 10 GB for temporary data files
Monitor with resolution of 1280x1024
SHILL Monitor with resolution of 1280x1024 ' CFSWwappable storage backplane for
Hardware multiple disk drives (optimal)

Option for remote system management

32-bit version of Microsoft® Windows® Dedicated Microsoft® Windows Server®
7 Professional 2012

The following environments are not supported:
* Citrix®
Environments * Microsoft® Small Business Server®
* Microsoft® Windows® 10
* Peer-to-Peer Networks
# Server Environments with 11S installed
* Terminal Services Environments

Adobe® Reader®

Internet Explorer®
Other Mi ft® NET F k
Software icrosoft™ . ramewor

Note: If Microsoft® Office is installed, the most recent service pack must be applied
before you install Scan components.

Virtualization VMware and Hyper-V are supported
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Suggestions for Achieving Optimal Performance with Scan Administrator

For best results, follow these guidelines for Scan Administrator:

# Do not install Scan Administrator on a computer that houses other critical applications, as it may
cause degradation in performance to other applications.

# |nstall and run Scan Administrator on multi-core processor systems, if possible. This allows
Scan Administrator and the Windows® operating system to distribute processes equally.

*# The Import, Archive, and Export folders can be on a workstation, fileshare, or server that is
separate from the Scan Administrator machine.

Recommendations for High-Volume Firms

If your firm processes a large number of Scan jobs, we recommend the following additional measures
to optimize performance:

* Drives should be high RPM, high capacity, Ultra/Wide SCSI-3 units.

# Disk controllers should include hardware-level support for RAID 0+1, provide on-board disk
caching of at least 32 MB, allow for Write-Back (write to RAM) caching, and provide
battery-backup for the onboard cache.

*= Network bandwidth should be multiplied by a factor of three or four or more (depending on your
workflow) to accommodate the image data that will be transferred. Scan Administrator moves
images and data across network connections. Depending on the number of workstations and
images you are processing, the network bandwidth required can be significant.

# Scan Administrator should be set up as a discrete sub-network isolated from other LAN
application to accommodate system traffic.

System Requirements for Scan Workstation

Scan Workstation is installed on workstations where Scan jobs are assigned. Once installed, use Scan
Workstation to monitor the workstation’s documents as they are processed. Scan Workstation also
allows you to do the following:

* Generate cover pages and target sheets prior to the initial scanning of Scan jobs
* Upload files to be submitted to Wolters Kluwer for review
®* Check to see if you have the latest catalog update installed

Chapter 1 - Overview and Installation « 5



Component Minimum Recommended

1.2 GHz Intel or AMD processor or 1.8 GHz Intel or AMD processor or
Processor . .
equivalent equivalent
RAM 1GB 2 GB
) 2 GB for program files 4 GB for program files
Disk Space ) .
2 GB for temporary data files 4 GB for temporary data files
Operatin
P 9 Microsoft® Windows® 7 Professional Microsoft® Windows® 7 Professional
System
_ Microsoft® .NET Framework 4.5.2
Operating . ® Aeeion i . .
If Microsoft™ Office is installed, the most recent service pack must be applied before
Software

you install Scan components.

Recommended Workflow for Installing Scan Components

For best results, we recommend using the following workflow to install the Scan components:

1. Identify the server or dedicated workstation where Scan Administrator will be installed.
Decide whether the Import, Archive, and Export folders will be located on the same dedicated
computer as Scan Administrator, or if they will be installed on another server or fileshare.

2. ldentify how many Import folders will be needed. When you install Scan Administrator, a
default Import folder is created for you. Your firm can have multiple Import folders as needed.
See Overview of Import, Archive, and Export Folders on page 13 for more information.

3. Identify the workstation or server where the Import folders will be located. Import folders
should be at a shared network location that Scan Administrator and all Scan Workstations can
access. Decide whether the Import, Archive, and Export folders will be located on the same
dedicated computer as Scan Administrator, or if they will be installed on another server or
fileshare.

4. Setaside time for installation. Schedule installation for a time when you can make the
transition without disrupting the office workflow. This reduces the risk of lost work time at the
office when you install.

5. Install Scan Administrator. This component should be installed on a server or dedicated
workstation. See Installing Scan Administrator on the next page for installation instructions.

Configure Scan for your firm’'s use. See Configuring Scan on page 12 for more information.

7. Install Scan Workstation and PDFlyer to individual workstations. These components
should be installed on any workstation where any of the following tasks will be performed:

®= Document scanning

®= Submission of scanned files for Scan processing
= Validation of extracted data

®* Sending extracted data to a tax return
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Installing Scan Administrator

We recommend that you install Scan Administrator on a dedicated server or workstation. Scan
Administrator cannot be installed on Citrix® or Terminal Services environments due to allocation of
memory resources. If you install Scan Administrator on a multi-processor server or workstation, Scan
distributes processes equally.

You must have administrator rights on the computer where you are installing Scan Administrator.

Note: If you are updating from a previous version of Scan, the installation program automatically
detects the earlier version of Scan and removes it.

To install Scan Administrator, do the following:

1. Log into the server or dedicated workstation where you plan to install Scan.

2. Download and launch the scan_us_11.x.x.x.exe file.

3. Click Setup.exe.

4. Click Install CCH ProSystem fx Scan. The installation wizard displays.

5. Click Yes to continue with the installation process without disabling your antivirus. Click No to
cancel the installation process.

6. Click Next.

7. Review the License Agreement and accept the terms of the agreement.

8. Click Next.

9. To change the destination folder where Scan is installed, click Browse and navigate to or enter

a new location. The default Import, Archive, and Export folders are added to the Scan shared
folder as part of the installation process.
10. Click Next.
11. Click Install. Wait for the installation to complete.
12. Select the permission key option for this installation. The options are as follows:
= Evaluation version. This option allows you to use Scan for a limited evaluation period.
If you have purchased a license for Scan, you should not select this option.
= Download permission key from the internet. Select this option if you will access your
permission key through the Support Web site. After clicking Next, you must log in to the
Single Sign-On (SSO) Web page with your user ID (account number) and password.
= Use existing permission key. If a permission key is detected on the server, this option

is selected by default, and there is no need to select a different option. If a permission
key is not detected, this option is disabled.

= Use permission key from drive path. Select this option to browse to a permission key
that is stored in a folder on the network or on a disk drive. Enter the location of the

permission key, or click the browse button (u) to locate the file.
13. Click Next.
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14. Select Reboot now to complete the installation process. You must restart your computer
before you can configure Scan Administrator and install Scan Workstation.

15. Click Finish.

Once installation completes, you can configure Scan Administrator. See Configuring Scan on page
12 for more information.

Running Services on a Scaled Server

If your firm processes many tax returns, using the Scaled Server installation can improve the overall
performance of Scan. With this installation, Scan Administrator is run on one dedicated server, while
Scan's most processing-intensive services, optical character recognition (OCR) and image
enhancement, can be run on one or more separate computers.

Scan Administrator must be installed on a dedicated server before Scan Scaled Server can be
installed. Do not install Scan Scaled Server on the same server where Scan Administrator is installed.
The operating system requirements for Scan Scaled Server are the same as for Scan Administrator.

Installing Scaled Server

If you are installing Scan Scaled Server for the first time, do the following:

1. Log into the computer that you will be using as the Scaled Server.
2. Browse to \\<computer name>\Scaled Server and launch the Setup.exe file.
3. Click Install CCH ProSystem fx Scan Scaled Server. The installation wizard displays.
4. Click Yes to continue the installation process without disabling your antivirus. Click No to cancel
the installation process.
5. Click Next.
6. Review the License Agreement and accept the terms of the agreement.
7. Click Next.
8. To change the destination folder where Scan is installed, click Browse and navigate to or enter
a new location.
9. Click Next.
10. Select the services to run on this scaled computer.
11. Click Next.
12. Enter the scan server, log on, and password where Scan Administrator is installed.
13. Click Next.

14. Click Install. Wait for the installation to complete.

15. Select Reboot now to complete the installation process. You must restart your computer
before you can use the Scaled Server.

16. Click Finish.

17. Verify that the installed service or services will start.
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Note: Depending on the processing capacity of the Scaled Server, you may want to configure
only one of the services on a single computer. If needed, you can add an additional Scaled Server
to run one of the services as well.

Configuring Scaled Server

Use the procedure below to configure a Scaled Server to run the Image Enhancement and OCR
services included with Scan. Depending on the processing power of the Scaled Server and the volume
of scanning your firm does, you may only want to run one service on this Scaled Server, and to run the
other service on another computer.

Select Administrative Tools from the Control Panel.
Select Services in the list.

Locate the service associated with the Scan components you installed on the Scaled Server.

M wbdh =

Right-click on the service you want to run from this server, and select Properties. Choose either
Image Enhancement or OCR.

Select the Log On tab.

o

Select This account, and enter the domain name and user name of an administrative user with
rights to both the Scan Administrator computer and the computer where Scaled Server is
installed. The information should be in this format: Domain\User name.

7. Enter and confirm the password of the administrative user.
If you installed additional services on this computer, repeat steps 1 through 7 to configure the
other services.

9. Click OK.

Note: When using Scaled Server to run Image Enhancement or OCR services, you may want to
stop those same services from running on the Scan Administrator server so that more resources
are available for running the remaining Scan services.

Installing Scan Workstation

If you are updating from a previous version of Scan Workstation, the installation program
automatically detects and removes the older version of Scan Workstation.

Note: Microsoft® .NET Framework 4.5.2 must be installed on each workstation running Scan
Workstation. If you have not already installed .NET Framework 4.5.2, it will be installed for you
during the installation.

To install Scan Workstation, do the following:

1. Browse to \\<computer name>\Workstation and launch ProSystem fx Scan Workstation.exe.
The installation wizard displays.

2. Click Next.
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Review the License Agreement and accept the terms of the agreement.

Click Next.
5. To change the destination folder where Scan Workstation is installed, click Browse and
navigate to or enter a new location.
Click Next.
Click Install. Wait for the installation to complete.
Click Finish.

After configuring Scan Administrator and installing Scan Workstation on at least one workstation, you
can use the 1040 or 1041 sample TIF file in the ProSystem fx Scan\Sample folder to verify that Scan
is working properly. The 1040 file is named John Smith - 1040 Sample File.TIF. The 1041 file is
named Rose Smith - 1041 Sample File. TIF.

After Scan Administrator is installed and configured, copy and paste the test file into an Import folder.
Scan automatically detects and processes the import file, then generates a bookmarked PDF file in
the Export folder.

Note: If you process a sample file multiple times, the first instance of the exported PDF file is
named 2014 John & Elizabeth Smith.pdf, and each additional instance increments by one (for
example, 2014 John & Elizabeth Smith-1.pdf). To prevent this, delete the sample file from the
Export folder each time you process it.

Getting Help with Scan

In addition to this guide, you can get additional information about Scan from the following resources:

= Online Help files. You can access the Scan Help file within the program by selecting Help >
CCH ProSystem fx Scan Help Topics or by pressing F1 on your keyboard.

= Knowledge Base. You can search for answers to specific questions in our Support Knowledge
Base at http://support.cch.com/answers.

#= Online chat. Our support representatives are available to take your questions via live online
chat. To use online chat, go to http://support.cch.com/chat/taxtechsupport. After entering
your name, email address, and account number into the online form, you will be connected to a
support representative.

= Telephone. You can call our support representatives at 1-800-PFX-9998, option 6.

Note: Normal business hours for our support representatives are 8 a.m. to 7 p.m. CT Monday
through Friday. Extended business hours, including some weekends, are available at select times
of the year.
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Chapter 2

ADMINISTERING SCAN

Using Scan Administrator

Although it is packaged as a single entity, Scan is actually a collection of several services. These
services are managed by the system administrator in Scan Administrator.

Scan Administrator includes five tabs, each of which allows the administrator to perform different
tasks. The main administrative duties include the following:

= Monitoring Scan jobs that are in process. Use the Queue tab to monitor and administer
Scan jobs. When you open Scan Administrator, the Queue tab displays by default. This gives
you quick access to information about jobs in the queue.

= Configuring folder settings for your firm. Use the Folder Settings tab to do the following:
®* Manage your 1040 and 1041 folders.
®= Select your Data Extraction Setting.
= Set up your Import, Archive, and Export folders.
* Enable image enhancements such as Border Removal and Auto Rotate.
= Allow files to be emailed to Wolters Kluwer.
= Select the type of blank pages to be removed.
= Select the OCR to use.
® Select the catalog to use.
= Configuring general settings for your firm. Use the General Settings tab to do the following:
®= Set how often files are checked to process.
® Set how often jobs are updated.
® Set how many files to capture at once.
* Set to automatically update Scan Administrator.
® Select how to import gain and loss transactions to Tax.
®= Allow to show which files are ready to import.
&= Allow files to be uploaded to Wolters Kluwer.
= Allow to overwrite default issuer information in Tax.

®= Allow to overwrite default recipient information in Tax.
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®= Allow to import wash sales when they are reported as "0.00" on brokerage statements.
= Allow to export gain and loss transactions to a PDF.
= Allow to always skip Form 1099-G during AutoFlow.

= Verifying the status of completed Scan jobs. Use the History tab to verify Scan jobs. You
can also access the files from a completed Scan job and export job history from this tab.

= Managing the services that are part of Scan. Use the Services tab to stop or start any of the
Scan services used to process Scan jobs.

To open Scan Administrator, do the following:

1. Select ProSystem fx Scan Administrator from the Start menu.
2. Enterthe user name and password for the computer where Scan Administrator is installed.
3. Click Logon.

Suggested Workflow for Administering Scan

You can use the following workflow to guide you in administering Scan. See the Installation Guide for
details on installing Scan Administrator, Scan Workstation, and PDFlyer.

Install Scan Administrator.

Set up Import folders for the firm.

Configure general firm-level settings for Scan.

Install Scan Workstation and PDFlyer on individual workstations.

a > wbdh =

When your firm begins processing documents, you can perform the following tasks as needed:
= Monitor the status of jobs that are in process.
= Verify the status of completed jobs.
= Export job history information.

= Control Scan processing services, as needed, for troubleshooting or project
management purposes.

Configuring Scan

After installing Scan, use Scan Administrator to peform the following configuration tasks:

= Set up Import folders. Import folders are the locations where Scan looks for scanned
documents to process. Scan monitors the Import folders on a continuous basis, processing jobs
according to priority levels that you assign. Import folders are created and configured on the
Folder Settings tab in Scan Administrator. You must set up at least one Import folder.
Depending on your firm's needs, you may need multiple Import folders to organize Scan jobs.

= Establish general settings for Scan. The general settings allow you to control how often
Scan checks for jobs and how quickly it begins processing. If your firm processes a high volume
of scans, you also may want to set the Limit Capture on the General Settings tab to control how
many files are processed at once.
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Overview of Import, Archive, and Export Folders

The Folder Settings tab in Scan Administrator is where you manage Scan folders. Scan stores source
documents and PDF files in three types of folders:

= |mport folders are the locations where Scan retrieves scanned documents for processing. You

can use a single default Import folder, or you can create additional Import folders. The following
are examples of how you can categorize your firm's Import folders:

= By scanner

= By priority

®= Bytask

= By staff member

®= By type of client
If you have more than one Import folder, Scan jobs are processed first by the priority assigned to
the Import folder, and then by the order that the Import folders are listed on the Folder Settings

tab. The system administrator can move Import folders up and down in the Folder Settings list
as needed.

Upon installation, Scan creates a Default 1040 folder and a Default 1041 folder.

Note: Two different Import folders are created, but the Archive and Export folders are
shared.

= Archive folders hold the scanned source documents after they are processed by Scan. An
Archive folder must be assigned to each Import folder. A single Archive folder can be assigned
to all your Import folders. If your firm processes a lot of scans, you may want to create multiple
Archive folders.

*= Export folders contain the bookmarked PDF files that are published by Scan. Like Archive
folders, you must assign an Export folder for each Import folder. A single Export folder can be
assigned to all your Import folders. If you want to keep the PDF files organized, you may want to
create multiple Export folders.

Setting Up an Import Folder

Scan picks up files for processing from the Import folders. You must set up at least one Import folder
when you configure Scan initially. You can add more Import folders at a later time in Scan
Administrator.

When you set up the Import folder you also must identify the following:

®* The Data Extraction Setting, Recognition Settings, OCR, and Catalog for source documents
from this Import folder

®* The Archive folder where the original scanned source documents from this Import folder will be
stored after processing

* The Export folder where the PDF files generated from documents in this Import folder will be
stored after processing
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Scan processes jobs in order of the priority assigned to the Import folders, and then in the order that
the folders display on the Folder Settings tab. You can move folders up or down in the list to set the
processing order. To reposition an Import folder, select it, and then click Up or Down to move it in the
list.

To add and configure an Import folder, do the following:

Open Scan Administrator on the server or workstation where Scan was installed.
Select the Folder Settings tab.

Click Add New.

Enter a unique name for the folder that clearly identifies its priority or purpose.

Select a priority level that will apply to files in this folder.
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Select a folder to use as the Import folder. To set up an Import folder, do the following:

Click the browse button (%) beside the Import Folder field.

Navigate to and select the folder where Scan should pick up files for processing. Keep in
mind the following:

®= Each Import folder must have a unique path.

®= |mport folders must be a valid shared folder (UNC), with access granted to both
the administrator and the workstation users who will need to use files in that
Import folder.

c. Click OK.

Note: An alert icon (:£) displays if you chose an Import folder that is not a shared
UNC folder. If this icon displays, you must go back and choose a valid folder.

7. Select a folder to use as the Archive folder for files after they are processed. To set up an
Archive folder, do the following:

a. Click the browse button (“-:::--) beside the Archive Folder field.
b. Navigate to and select the folder that Scan should use for archiving source documents
from this Import folder after they are processed. Keep in mind the following restrictions:
®= The Archive folder cannot be used as any other type of folder (Import or Export).
*= |f needed, you can use the same Archive folder for all source documents,
regardless of which Import folder the documents came from.
c. Click OK.
8. Select Archive to Subfolders to create a subdirectory for archive storage. If this option is
selected, the source file is moved to a subdirectory in the Archive folder after processing.

9. Select a folder to use as the Export folder. This folder will hold the bookmarked PDF files that
Scan generates. To set up an Export folder, do the following:

a. Clickthe browse button (“::::-) beside the Export Folder field.

b. Navigate to and select the folder where Scan should store the bookmarked PDF files.
Keep in mind the following restrictions:
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10.

11.

C.

®= The Export folder cannot be used as any other type of folder (Import or Archive).

= |f needed, you can use the same Export folder for all source documents,
regardless of which Import folder the documents came from.

Click OK.

Select Export to Subfolders to create a subdirectory for export storage. If this option is
selected, the bookmarked PDF file is moved to a subdirectory in the Export folder once a Scan
job is completed.

Select options for each folder.

a.

Select Identify and Bookmark if you want the PDF files created by Scan to be
bookmarked automatically. This option must be enabled if you plan to import data.

Select Border Removal to remove the borders on the margins of the page, regardless
of whether or not the border is printed on all four sides of the page.

Select Enable Files To Be Emailed to Wolters Kluwer to have the option of sending
problematic files to the Scan Catalog team for possible inclusion in the Scan Catalog. If
selected, newly extracted files can be emailed from the Scan Validation window.

Note: Yourimported file can also be emailed directly to the Scan Catalog team at
scancatalog@wkglobal.com. This file can be located in your Archive folder at
C:\ProSystem fx Scan\ProSystem fx Scan Shared\Archive.

Select Submit AutoFlow Usage Statistics to automatically provide Wolters Kluwer
with nonsensitive information about how your firm uses Scan.

Choose an option in the Remove Blank Pages field to indicate which criteria to use
when removing blank pages. Select one of the following:

= Disable. Do not remove any blank pages.
= Dirty. Remove blank pages that are dirty white with speckles or dots.

= Very Dirty. Remove blank pages that are very dirty or have dark creases or staple
marks.

= Single Line Pages. Remove blank pages if they contain one visible line of text
reading This Page is intentionally left Blank.

Select an OCR method. AFR OCR is the default and recommended method.

Select a Catalog. The Catalog controls whether the file is bookmarked as a 1040 or
1041 return.

Select a Type. The Type displays only for Catalog US 1040. This controls the bookmark
structure of the PDF files generated from the Import folder. Choose one of the following:

» Original conforms to the structure of the 1040 tax return.
= QOrganizer conforms to the structure of the Tax Organizer.

Select the number 0 for Auto Rotate if you do not want the documents in your file to be
rotated. The default is 30, which is the recommended Auto Rotate setting.

12. Select the extraction option to use for the Import folder.
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= Do Not Extract Data. No data will be extracted.

= Extract Data for AutoFlow. If this option is selected, you can extract and validate data
from jobs scanned into this Import folder. This option must be selected if you do not plan
to use an extraction cover page or if you want to import extracted data into a tax return.

= Extract Bookmark Names Only. If this option is selected, you will only be able to
extract the bookmarks from the PDF files.

Note: If you use a cover page, the cover page settings override the options selected here.
13. Click Save.

Note: If you have multiple Import folders and you limit the number of files that Scan processes
on the General Settings tab, reserve the top Import folder for rush jobs. This folder should be
assigned the High priority level. Jobs placed in this folder will be captured and processed first.

Modifying Settings for an Existing Import Folder
To modify the settings for an existing Import folder, do the following:
Open Scan Administrator on the server or workstation where Scan was installed.

Select the Folder Settings tab.
In the list of Import folders on the left, select the Import folder to modify.
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Change the settings for the folder as needed. See Setting Up an Import Folder on page 13 for
detailed information about the settings on this tab.

5. Click Save.

Changing the Processing Order for Import Folders

Scan jobs are processed first by the priority assigned to the Import folder, and then by the order the
Import folders are listed on the Folder Settings tab in Scan Administrator. You can move Import
folders up or down in the list to change the order in which files are processed. If the folder order must
be modified after initial setup, we recommend waiting until a time when no jobs are being processed.

To move an Import folder up or down in the list, do the following:

Open Scan Administrator on the server or workstation where Scan was installed.
Select the Folder Settings tab.

Select the Import folder to move in the list.

Click Up or Down to move the folder to the appropriate position in the list.

Click Save.
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Note: If you use the Limit Capture option on the General Settings tab, your ability to change the
priority of specific batch jobs is reduced. For best results when using this option, reserve the top
Import folder in the priority list for rush jobs. If you apply the High priority setting for this folder,
jobs placed in it will be captured and processed first.
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Removing an Import Folder

The following procedure disables Scan processing for a selected Import folder. It does not physically
remove the folder from the server. To remove a folder from the server, use Windows® Explorer.

Note: Before removing a folder, verify that it is empty and that all Scan jobs have been captured
and processed.

To remove an Import folder from Scan processing, do the following:

Open Scan Administrator on the server or workstation where Scan was installed.
Select the Folder Settings tab.

In the folder list on the left, select the Import folder to remove.

Click Remove. A message asking if you want to delete the folder displays.

Click OK.
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Setting Scan Defaults

Scan continually monitors the Import folders and starts a new Scan job when it detects a new scanned
file. The General Settings tab in Scan Administrator allows you to control how often Scan checks for
new files and how many files Scan captures at once. The selected settings apply to all Import folders.

Note: The Install Status section displays the license information for your installation of Scan.
There are no settings to modify in this section.

To modify the Scan general settings, do the following:

1. Open Scan Administrator on the server or workstation where Scan was installed.
2. Select the General Settings tab.
3. Inthe General Settings section, change the settings as needed to meet your firm's needs.

= CheckEvery ___ Seconds for New Files to Capture. This setting determines the
time lapse before Scan checks for a new file in an Import folder. Enter a value between
20 seconds and 600 seconds (10 minutes).

= Update Jobs Every ___ Seconds. This setting determines how often the job
information displayed on the Queue tab and Scan Workstation is refreshed. Enter a
value between 20 seconds and 600 seconds (10 minutes).

= Capture Wait Time ____ Seconds. This setting determines the minimum amount of
time that a file must be in the Import folder before Scan processes it. Set the wait time to
ensure that a file has not changed in the time that elapses before Scan processes the
file. If a file is modified during this wait period, Scan will try to import the file after the
wait time has elapsed again.
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Limit Capture to ____ Currently Processing Files. This setting determines the
number of files Scan can process simultaneously. Set the capture limit high enough to
process your normal workload.
= If you set the number too low and have multiple Import folders, jobs in low
priority folders or in folders at the end of the Folder Settings list might be stalled
since higher priority jobs are captured first.
= If you use this option, reserve the top spot on the Import folder list in Folder
Settings for rush jobs, setting the priority level to High. This will ensure that jobs
in this folder are processed first.

Auto Update At. This option is selected by default and checks for a new version of
Scan. If a new version of Scan is available, Scan Administrator will update at 2 a.m. You
can change the time if you prefer to update Scan Administrator at a different time.

If you prefer to manually check for updates, clear this box. Click Check Now whenever
you want to check for Scan updates. If an update is available, Scan Administrator will
automatically close, and the update will be installed.

Note: This option only applies to Scan Administrator. If Scan Workstation needs to
be updated, you will be prompted to update when you open Scan Workstation. An
alert icon (<) also displays on Scan Workstation as a reminder that a Scan
Workstation update is available.

GA&L Excel Settings. By default, All Statements on One Tab is selected. This selection
imports all gain and loss statements to the Excel spreadsheet on one tab. If you want
each gain and loss statement to import on separate tabs, select One Statement Per Tab.

Show Files Ready to Import. Select this option if the files waiting to be captured
should display in the Queue with a priority of Ready and a corresponding message of File
Ready for Import. This option works correctly if Limit Capture is set above zero.

Enable Files To Be Uploaded To Wolters Kluwer. Select this to have the option of
uploading problematic files to the Scan Catalog team for possible inclusion in the Scan
Catalog. Files can be uploaded from Scan Workstation or the Scan Validation window.
Overwrite Default Issuer Information in Tax. This option is selected by default and
will overwrite the default issuer/payer information in Tax. If you do not want the
issuer/payer information to be overridden, clear this box.

Note: This option is also available in the Review Tax Forms window. This gives you
the flexibility to make a different selection per form.

Overwrite Default Recipient Information in Tax. Select this option if you want to
overwrite the default recipient information in Tax.

Note: This option is also available in the Review Tax Forms window. This gives you
the flexibility to make a different selection per form.

Import 0.00 Wash Sales. This option is selected by default and will import wash sales
when they are reported as "0.00" on brokerage statements. Clear this box if you do not
want the "0.00" wash sales to import to Tax.
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= Export G&L Transactions to a PDF. Select this option if you want Scan to generate a
PDF file that contains the brokerage statement pages with gain and loss transactions.
This option is useful for firms that attach the brokerage statement pages, which contain
the gain and loss transactions, to the tax return instead of importing them individually to
Tax. This PDF file will show as an attachment to the bookmarked PDF file.

= Always skip Form 1099-G on AutoFlow. This option is selected by default and will
always move Form 1099-Gs to the Skipped section during the AutoFlow process. If you
do not want Form 1099-Gs to always be skipped, clear this box.

4. Click Save.

Monitoring Scan Processing with the Queue

The Queue tab in Scan Administrator shows you a list of all the documents that are being processed,
as well as a description of the job status.

From the queue, you can perform the following tasks:

# Change the priority of a job

® Start or stop a job

* Remove ajob

* Reset a validation lock

®* Import documents for Scan processing

Note: Staff members using Scan Workstation can monitor the progress of Scan jobs using the
Scan Workstation.

Changing the Priority of a Job

You may need to change the priority of a job to meet deadlines. By default, a job's priority level is
determined by the priority assigned to the Import folder that it originates in. Changing a job's priority
allows the job to be processed before jobs of lower priority and after jobs of higher priority.

To change the priority of a single job in the queue, do the following:

Open Scan Administrator from the server or workstation where Scan was installed.
Select Queue.

Find the job in the list of Scan jobs.

Right-click the job, and then select Set Priority from the menu.
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Select the priority level for the job.
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Starting and Stopping a Job
To start or stop a job in the queue, do the following:
Open Scan Administrator on the server or workstation where Scan was installed.
Select Queue.
Find the job in the list of Scan jobs.
Right-click the job, and then select Set Priority from the menu.
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Do one of the following:

= To stop ajob in progress, select Stop. The job remains on the queue unless you delete it
manually.

®= To restart a job, select a priority level (High, Medium, or Low).

Note: Once afile is imported into the queue, the only way you can edit it is to stop the file, save it
to a safe location, make your edits, and then re-import the file into Scan. Likewise, if a file will not
process because of an error, you must delete the job, save the file to another location, make
modifications to it outside of Scan, and then re-import it into Scan.

Removing a Scan Job from the Queue

You can delete a Scan job from the queue while they wait for processing or during the processing
cycle. To remove a job from the queue, do the following:

Open Scan Administrator from the server or workstation where Scan was installed.

Select Queue.

Find the job in the list of Scan jobs.

Right-click the job, and then select Set Priority > Stop.

Right-click the job again, and then select Delete.
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When the system asks if you want to save the import file, do one of the following:

= Click Yes to save the original import file to another location before deleting the job.
Enter a file name and select the location to save the import file. Then, click Save.

= Click No to delete the job from the queue and the Pending folder without saving it.

Refreshing the Queue

One of the items that you configure when you select general settings for your firm is how often Scan
refreshes the job information displayed on the Queue tab.

* |f you need to permanently change how often the queue is refreshed, you can change that
setting by following the instructions in the topic Setting Scan Defaults on page 17.

# |f you need to refresh the list of jobs in between the scheduled updates, click Refresh on the
Queue tab or press F5 on your keyboard.
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Unlocking a PDF File during Validation

Occasionally a PDF that is being validated may become locked, either because multiple people are
attempting to access it at once or because there is an error on the workstation where validation is
taking place. When this occurs, the system administrator can unlock the file by doing the following:

Open Scan Administrator from the server or workstation where Scan was installed.
Select Queue.
Find the job in the list of Scan jobs.
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Right-click the job, and then select Reset Validation Lock from the menu.

Viewing Job History Information

Information about completed Scan jobs is recorded on the History tab in Scan Administrator. If
needed, you can review the information on this tab to verify that a particular job completed
successfully. You also can export information from this tab to an Excel file so that the information is
available to people who do not use Scan.

The following information is recorded on the History tab for each completed Scan job:

* Time imported
* Pages imported
* Import file

* Time exported

* Page exported

* Export file

* Time elapsed

Note: Click on the column headings to sort the columns in ascending or descending order.

# You can only sort by one column at a time.

* \When sorting within a range of dates, the sort applies within each date and is not cumulative
throughout the range of dates.

® You can sort columns based on the Setting Name.

* You can also sort data by the date range using the From and To calendar drop-down menus.

There are also two summary fields that display at the bottom of the window. These are totals for the
selected Import folder during the selected date range.

* Files Imported reflects the total number of files for the selected Import folder during the
selected date range. The number in parenthesis indicates the total number of pages imported
for all Scan jobs listed, including cover pages and target sheets.
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* Files Exported reflects the total number of files for the selected Import folder during the
selected date range. The number in parenthesis indicates the total number of pages exported
for all Scan jobs listed, excluding cover pages, target sheets, and blank pages.

On the History tab, you can access the files in the Archive and Export folders. To access the Archive or
Export folders or files on the History tab, right-click a Scan job and select one of the following:

= Open Archive Folder. Opens the Archive folder selected on the Folder Settings tab in Scan
Administrator.

= Open Archive File. Opens the archived file.

= Open Export Folder. Opens the Export folder selected on the Folder Settings tab in Scan
Administrator.

= Send Export File to Document. Sends exported files to Document. This option is only
available if Document is installed. See the Document Help files for detailed information about
sending export files to Document.

= Open Export File. Opens the exported file.

Note: A yellow triangle with an exclamation point (._fl\.) next to the Scan job indicates that either

the archive or export file is missing. A red circle with an exclamation point (0) next to a Scan job
indicates that both the archive and export files are missing.

Verifying Successful Completion of a Scan Job

To verify that a Scan job processed successfully, you can do the following:

1. Open Scan Administrator on the server or workstation where Scan was installed.
2. Select History.

3. If needed, narrow the list of Scan jobs by using the filter fields at the top of the window. Choose
from the following filters:

= Setting Name. Select the Import folder where the Scan job originated.
= From. Enter the first date that the file may have been processed.
= To. Enter the last date that the file may have been processed.

4. Review the list of jobs to verify that processing was completed. You can compare the page
count from the original import file to the exported PDF file to ensure that no pages were lost.

= The Files Imported totals reflect all pages, including cover pages and target sheets, in
the original file.

= The Files Exported totals reflect all pages in the original import files, excluding the
cover pages, target sheets, and blank pages that were removed.

Note: We recommend backing up the archive folder on a regular basis. You also may want to
purge the archive folder periodically to free up space on the server.
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Accessing a Completed Scan Job

On the History tab, you can open an archive folder or file, or an export folder or file for a completed
Scan job. To view a file for a completed Scan job, do the following:

1. Open Scan Administrator on the server or workstation where Scan was installed.
2. Select History.

3. If needed, narrow the list of Scan jobs to export by using the filter fields at the top of the window.
The following filters are available:

= Setting Name. Select the Import folder where the Scan job originated.
= From. Enter the first date that the file may have been processed.
= To. Enter the last date that the file may have been processed.

4. Inthe list of jobs, double-click the job you want to view.

Note: If the job you are looking for was processed recently but does not display in the list, click
Refresh to update the list.

Exporting Job History to an Excel Spreadsheet

To export job information from the History tab to an Excel spreadsheet, do the following:

1. Open Scan Administrator on the server or workstation where Scan was installed.
2. Select History.

3. If needed, narrow down the list of Scan jobs by using the filter fields at the top of the window.
The following filters are available:

= Setting Name. Select the Import folder where the Scan job originated.
= From. Enter the first date that the file may have been processed.
= To. Enter the last date that the file may have been processed.
Click Export.
Navigate to and select the location where you want the Excel spreadsheet to be saved.
Enter a file name for the Excel spreadsheet.
Click Save.
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Managing Scan Services

Scan is a collection of services that work together to process your scanned documents. You can start
or stop services on the Services tab in Scan Administrator. You can use this capability to troubleshoot
problems or to temporarily suspend all Scan jobs, if needed.

The services included in Scan are as follows:

*= Folder Monitor monitors Import folders for files to be processed. It also updates batch
statistics per the Import Status folder.

= Quality Assurance detects rotation, skew, and noise in the image and other characteristics
necessary forimage enhancement prior to form classification.

* Image Rotation rotates the images to an upright position prior to form classification.
= |mage Enhancement deskews, despeckles, and removes blank pages if detected.

*= Border Removal removes borders on the margins of the page, regardless of whether or not the
border is printed on all four sides of the page (if detected).

= Multi splits individual pages into distinct documents and jobs based on cover pages. It also
splits single and multi-page documents based on target sheets and deletes blank pages and
target sheets from the batch. It also deletes the entire batch when completed.

= ScanSoft OCR is an alternative OCR service that performs optical character recognition (OCR)
on each form. It converts images to text and a single page PDF file for folders set to SS OCR.

= AFR OCR performs optical character recognition on each form. It converts images to text and a
single page PDF file for folders set to AFR OCR.

= |mage Export converts images to a single page PDF file and exports them to the Pending
folder for processing. This service is used when neither Identify and Bookmark nor Create
Searchable PDF are selected on the Folder Settings tab or in the event of an OCR error.

= (Classification assigns each document to a predefined template for PDF bookmarking.

= PDF Export creates the bookmarked PDF file from single page PDF files and creates
bookmarks based on the classification. It then exports the bookmarked PDF file to the
designated export folder.

Configuring Scan Services

Scan Services can run as local system services or as system admin services. By default, all services
are set to run as local system services.

* |f the Import, Archive, and Export folders are on the same computer with Scan Administrator,
the services should be run as local system services.

* |f the Import, Archive, and Export folders are located on a computer other than the one where
Scan Administrator is installed, then the Folder Monitor and PDF Export Scan services should
be run from a system administrator account.

Chapter 2 - Administering Scan « 24



To change the user for the Folder Monitor and PDF Export services, do the following:

Right-click My Computer.

Select Manage.

Double-click Services and Applications.
Double-click Services.
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Scroll down to the services listed for CCH ProSystem fx Scan, and then scroll to the right until
you see a Log On As column.

Right-click Folder Monitor, and then select Properties.
Click the Log On tab.
Select This account.
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Enter the user name and password for the administrative account that you want to use.
10. Click OK.
11. Repeat steps 6 through 10, this time selecting PDF Export instead of Folder Monitor.

Note: You must stop and restart a service after a change has been made.

Starting or Stopping Scan Services

To stop or start a Scan service, do the following:

1. Open Scan Administrator on the server or workstation where Scan was installed.
2. Select Services. See Managing Scan Services on the previous page for service descriptions.
3. Do one or more of the following as needed:

= Click Stop if a service is running and you want to stop it now.

= Click Start if a service is not running and you want to start it now.

= Click Start All Services or Stop All Services to manage all services at the same time.

= Click Refresh to refresh the list to see if any services are currently not running.

Checking for Catalog Updates

To determine if you have the latest Scan catalog installed, do the following:

1. Open Scan Administrator from the server or workstation where Scan was installed.
2. Select Help.
3. Select Check for Catalog Update.

= |f you do not have the latest catalog installed, Catalog Update Available displays.
Follow the instructions to download the latest catalog.

= |f you have the latest catalog installed, No catalog update available displays.
4. Click OK.

Note: The catalog update must be run from the Scan Administrator computer.
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Chapter 3

USING SCAN WORKSTATION

About Scan Workstation

Scan Workstation includes several small modules that allow you to manage various parts of your Scan
jobs. These components are as follows:

* The Import Assistant provides an easy way to move scanned documents into an Import folder
for Scan processing.

# Scan Workstation allows you to monitor the progress of Scan jobs. You can also print cover
pages and target sheets from this module and check for catalog updates.

®* The History window provides information on completed Scan jobs and allows you to import files
into Document.

®* The Upload window allows you to submit problematic files to the Scan Catalog team for
possible inclusion in the Scan catalog.

®* The AutoFlow Wizard provides you the ability to export extracted data from a PDF to Tax.

* The Scan Validation window gives you tools to compare data that Scan extracted from a PDF
against the original scanned documents.

Scan Workstation is typically installed on workstations where scanning devices are located. You can
also install it on workstations where Scan jobs are assigned. If staff members handle their own
scanning and Scan processing, Scan Workstation should be installed on their workstations as well.
Workstations must have access to the shared Import folders to monitor jobs in Scan Workstation.

To open Scan Workstation, select ProSystem fx Scan Workstation from the Start menu. The Scan
Workstation module opens and can be minimized to your task bar.

Recommended Scan Workflow

Following the workflow outlined below will help you use Scan Workstation to its best advantage.

1. Sort the documents to determine which ones need to be scanned, preparing the documents for
scanning as you go. See Preparing Documents for Scanning on page 29 for more information.

2. Organize the documents in the order that you want them to be scanned. For most efficient
processing, place single-page documents on top of the stack to be scanned, with multi-page
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documents below. Scan re-orders and bookmarks all documents in the bookmarked PDF file to
match the tax return.

3. If needed, print and insert cover pages and target sheets. See About Cover Pages and Target
Sheets on page 29 for more information.

4. Count the total number of pages to be scanned, excluding cover pages, target sheets, and blank
pages. Write down this number so that you can verify that all of the pages are included in the
bookmarked PDF file.

5. Configure your scanner according to the guidelines outlined in Scanner Settings on page 84.

6. Place the documents on the scanner, top first. Multiple jobs can be placed in the scanner at one
time as long as each job is separated with a cover page.

7. Scan the documents. You can scan them directly into an Import folder, or, if needed, you can
scan them to an intermediary folder, and then transfer them into an Import folder using Scan's
Import Assistant.

8. Monitor processing of the scanned images.
9. Verify successful completion of the Scan job.

10. Remove the target sheets, if any.
After you complete Scan processing, you can choose to do any of the following:

*# Validate that the tax data converted through optimal character recognition (OCR) in the
bookmarked PDF file was transferred correctly. See Validation Overview on page 40 for more
information.

= Use AutoFlow Wizard to export tax data from the PDF into a tax return. See Integrating with
Tax on page 48 for more information.

* Complete processing without validating the data.

Note: In addition to documents needed for tax preparation, you can scan checklists or forms that
your firm uses for managing client projects. You can generate Force Specific Classification target
sheets for these documents to ensure their proper classification in the PDF file.

Using Scan Workstation

Some of the tasks you can perform from Scan Workstation include:

®* Monitoring a Scan job that is in progress

* Printing cover pages and target sheets

# Uploading files to be submitted to Wolters Kluwer for review

®# Checking to see if the latest catalog update is installed

*  Accessing the Import Assistant and importing files for Scan processing

* |aunching AutoFlow Wizard to export extracted data to a tax return

* Opening the Scan Validation window to verify the accuracy of extracted data
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Although it is not required, we recommend that you take time to configure the settings before you
begin processing Scan jobs. These settings ensure that you receive timely updates about the status of
jobs submitted for processing. If your firm uses cover pages and target sheets, you should also set up
a default printer for printing those pages.

Modifying the Scan Workstation View

The File menu in Scan Workstation includes options that allow you to change how Scan Workstation
displays on your monitor. The viewing options available to you are listed below, along with instructions
for using them.

= Always display Scan Workstation on top of other windows. When this option is selected,
Scan Workstation will always be on the forefront of your computer desktop. To toggle this option
on or off, select File > Display > Always on Top.

= Make Scan Workstation transparent. This option allows you to view Scan Workstation, even
if it is set to display on top of all other windows. To make the window transparent, select File
> Display > Transparency, and then select a transparency percentage.

= Setthe interval between screen updates. Scan Workstation will update the list of jobs at
the end of the time frame selected here. To set how long a period should pass between screen

updates, select File > Monitor Update Time, and then select the period of time you want to
pass between updates.

Configuring a Default Printer for Cover Pages and Target Sheets

Cover pages and target sheets are printed from Scan Workstation. You can select a printer to be the
default printer for cover pages and target sheets using the procedure below.

Note: If the printer you want to use as the Scan default printer is not already set up on your
computer, you should ask your system administrator for assistance in setting it up before you
attempt to select it as a default printer in Scan Workstation.

To select a default printer for cover pages and target sheets, do the following:

1. Open Scan Workstation.
2. Select Print > Setup Default Printer to display the Print window.

3. Inthe Name field, select a printer that you want to use as the default printer for cover pages and
target sheets.

4. If needed, click Properties to set up specific options for the selected printer. The available
options depend on the type of printer you use. Click OK to return to the Print window.

Note: Do not set the printer to print on both sides of the page.

5. Click OK.
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Preparing Documents for Scanning

We recommend that you prepare your original documents for scanning by doing the following:

®* Remove staples and fan out pages.

* Unfold pages and bent corners.

* Move or remove sticky notes so they do not cover pertinent data. You may want to attach them
to a blank sheet of paper and include a reference to the original page. To prevent notes from
being misplaced, you can also tape them down or place the sheets in a scanning sleeve.

* Place small or delicate pages in a scanning sleeve.

About Cover Pages and Target Sheets

Cover pages and target sheets can be used to ensure that Scan organizes and bookmarks PDF files
correctly. They are printed from Scan Workstation. They are then inserted between the individual
documents included in a Scan job. When the stack of documents is scanned, Scan inserts a new
bookmark whenever it detects a target sheet. There can be as many target sheets in a Scan job as
there are client documents.

Neither cover pages nor target sheets are required, although there are instances when both are
recommended. Because they are not client specific, target sheets can be printed in bulk, and then
used repeatedly.

Note: When a target sheet is not included in a Scan job, Scan considers each scanned page to
be its own document. A bookmark is created for each page.

See the following sections for information about printing and using target sheets.

Using Cover Pages

When using a cover page, place it on top of documents to be scanned. The bar code on the cover
page tells Scan to begin a new Scan job. If you want the export file to be named differently than the
import file, you can enter it on the cover page.

A special kind of cover page, called an Extraction Cover Page, indicates to Scan that the data in the
scanned documents should be extracted. You can use this cover page when the Import folder for the
job is not configured to allow extraction.

Some general guidelines for using cover pages are as follows:

* |f you scan documents for multiple clients in one scanning session, you should insert cover
pages at the beginning of each client's scan job to ensure that information for each client is kept
in a separate PDF file.

* |f you only scan information for a single client at a time, you may not need to use a cover page.
In that case, the name of the original scanned file will be used to name the exported PDF and
archive files.
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* |f your firm also uses Document, use the Document Routing Slip instead of the Scan cover
page. The bookmarked PDF file is automatically routed to the proper client in Document, based
on the data entered for the Routing Slip in Document.

Note: If you use a Document routing slip, you should not also use a Scan cover page.
Doing so will cause an error in Scan.

* |f you plan to use AutoFlow Wizard to import extracted data to a tax return, you must either use
an extraction cover page or set the Import folder that will hold the Scan job to extract data.

Cover pages have two bar codes. The first bar code alerts Scan to capture the Scan job. The second
bar code embeds the document name. Scan applies this document name to both the exported PDF
and archive files.

Printing Cover Pages

To print a cover page, do the following:

1. Open Scan Workstation.
Select Print > Cover Pages/Target Sheets from the menu.

Select US 1040 if you are processing a 1040 tax return. Select US 1041 if you are processing a
1041 tax return. This will print on your Cover Page.

4. Enter a unique name for the document, and then click Add.
Repeat steps 3 and 4 until you have added all the cover pages that you want to print to the list.

Select Extraction Cover Page if you want to override the Import folder settings and extract
data from the PDF file.

Note: If you use Force Specific Classification target sheets in a Scan job with an extraction
cover page, 1040 and 1041 form information is not extracted from the documents
associated with the Force Specific Classification target sheets.

Click Print. Once printed, the documents are cleared from the list.

Click Close.

Note: You can print target sheets at the same time you print cover pages. To do so, click the
Target Sheets tab before you send the cover pages to print, and then add the target sheets.
When you have added all the target sheets, click Print, and all the cover pages and target sheets
will print at one time.

Using Target Sheets

A target sheet indicates to Scan where it should insert bookmarks when it generates a PDF. When
used, a target sheet is placed on top of a document within the stack of documents to be scanned.
There can be as many target sheets in a Scan job as there are client documents. Because they are not
client specific, target sheets can be printed in bulk, and then used repeatedly.
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Note: When a target sheet is not included in a Scan job, Scan considers each scanned page to
be its own document. A bookmark is created for each page.

There are three types of target sheets:

= Single page target sheets indicate that the following document is a single page. Single-page
target sheets are not needed if your entire scan job consists of single-page documents. When a
target sheet is not included, Scan considers each scanned page to be its own document, and
inserts bookmarks accordingly.

* Multi-page target sheets identify documents of more than one page. Scan inserts a single
bookmark for all the pages of the document when it detects a multi-page target sheet.

Scan can automatically group the pages of some multi-page documents together, even if a
multi-page target sheet is not used. For the multi-page forms listed below, Scan attempts to
auto group the pages into the same bookmark if they have either the same account number on
all pages or sequential page numbering.

The forms that Scan can autogroup include:
= 1098
= 1099-B
= 1099-DIV
= 1099-INT
= 1099-MISC
= 1099-0OID
= 1099-Q
= 1099-R
= Brokerage Statement
= Combined Tax Statement
®= Mortgage Interest Statement

» Forced specific classification target sheets can be printed to force documents to be classified
in a specific bookmark in the PDF file. 1040 and 1041 tax form information cannot be extracted
from documents using these types of target sheets. Do not use these target sheets if your firm
plans to extract data for tax processing.

Best Practices for Using Target Sheets

A target sheet can be used to ensure that Scan organizes and bookmarks PDF files correctly. They are
printed from Scan Workstation. They are then inserted between the individual documents included in
a Scan job. When the stack of documents is scanned, Scan inserts a new bookmark whenever it
encounters a target sheet. There can be as many target sheets in a Scan job as there are client
documents.

Target sheets are not required, although there are instances when they are recommended. Use the
tips below to help you decide when to use target sheets.

Note: For instructions on printing target sheets, see Printing Target Sheets on the next page.
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* Print your target sheets instead of photocopying them. Copies tend to degrade, which can make
it more difficult for the scanner to read the bar code.
* Minimize the number of target sheets that are needed.
®= |f your Scan job contains only single-page documents, target sheets are not needed.
Scan will treat each individual page as its own document, and will create a bookmark for
each page.
= |f your Scan job contains both single-page and multi-page documents then do the
following to reduce the number of target sheets needed:
A. Sort the documents to be scanned into separate stacks for single-page and multi-
page documents.

B. Insert any needed multi-page target sheets.

C. Place the stack of single-page documents on top of the multi-page documents,
then single-page target sheets will not be needed. In the absence of a preceding
target sheet, Scan automatically recognizes the documents as single pages.

* A document with instructions on a second page can be a single or multi-page document. When
scanned with the single-page documents, Scan creates two bookmarks (one per page) in the
PDF file. When scanned with the multi-page documents, Scan creates one bookmark with two
pages in the PDF file.

* When using a multi-page target sheet, make sure that the first form immediately following the
target sheet is how you want the multi-page document/group to be classified.

# Client Organizers can be either a single or multi-page document. When scanned with the single-
page documents, Scan splits the Organizer apart and files each page with the supporting
workpapers. When scanned with the multi-page documents, Scan groups all of the pages of the
Organizer together under one bookmark.

* Reuse your target sheets. Because they are not client-specific, target sheets can be reused for
multiple Scan jobs.

Printing Target Sheets

A target sheet can be used to ensure that Scan organizes and bookmarks PDF files correctly. They are
printed from Scan Workstation. They are then inserted between the individual forms included in a
Scan job. When the stack of forms is scanned, Scan inserts a new bookmark whenever it encounters a
target sheet. There can be as many target sheets in a Scan job as there are client documents.

Target sheets are not required, although there are instances when they are recommended. Because
they are not client specific, target sheets can be printed in bulk, and then used repeatedly. When a
target sheet is not included in a Scan job, Scan considers each scanned page to be its own document.
A bookmark is created for each page.

Note: To open and print a target sheet, you first must have a PDF reader such as Adobe®
Reader® installed on your computer.
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To print target sheets, do the following:

Open Scan Workstation.
Select Print > Cover Pages/Target Sheets from the menu.
Select the Target Sheet tab.

M owbdh =

Select the type of target sheet you want to print. See Using Target Sheets on page 30 for more
information about each type of target sheet.

= Single-page target sheets are used before documents that only have one page.

= Multi-page target sheets identify documents of more than one page. Scan inserts a
single bookmark for all the pages of the document when it detects a multi-page target
sheet.

Notes:

= Scan can automatically group the pages of some multi-page documents together,
even if a multi-page target sheet is not used. See Using Target Sheets on page
30 for a list of forms that Scan can group automatically without a multi-page
target sheet.

= Sample TIF files of single-page and multi-page target sheets are available in the
ProSystem fx Scan\Sample folder.

5. To print a target sheet that forces a document into a particular bookmark, do the following:

a. Select the catalog that you want to print target sheets for. Your selection will print on the
target sheet.

» Select US 1040 if you are processing a 1040 tax return.
» Select US 1041 if you are processing a 1041 tax return.
b. If you are using US 1040, select the catalog type that you want to print target sheets for:

= Select Original if the Class bookmarks should conform to the 1040 tax return
(Organizer, Wages, Schedule B-Interest, Schedule B-Dividend, etc.).

= Select Organizer if the Class bookmarks should conform to the Tax Organizer
order (Check List, Tax Organizer, Topic Index, Questions, Electronic Filing,
General, Personal Information, etc.).

c. Select Force specific classification.

Note: 1040 and 1041 tax form information cannot be extracted from documents
using Force Specific Classification target sheets. Do not use this target sheet if your
firm plans to extract data for tax processing.

d. Select the class of bookmark you want to print. The class indicates a main tax form or tax
information classification.

e. Select the specific form that you want to force a bookmark for. The form is generally a
specific tax form.

6. Click Add.
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7. Repeat the previous steps as needed to add all the new target sheets.
8. Click Print. Once printed, the documents are cleared from the list.
9. ClickClose.

Note: You can print cover pages at the same time you print target sheets. To do so, click the
Cover Page tab before you send the target sheets to print, and then add the cover pages. When
you have added all the cover pages, click Print, and all the target sheets and cover pages will
print at one time.

Special Considerations When Scanning Tax Forms for Data
Extraction

Scan can extract data from scanned documents so that the data can be imported into a tax return.
The procedure for scanning documents is the same as for other documents, except that one of the
following must be true for the data to be extracted:

®# The scanned image file should be submitted for processing to an Import folder that is configured
to allow extraction.

* |f the file will be submitted to an Import folder that is not configured to allow extraction, then an
extraction cover page should be the first document scanned for the job.

Tax form information cannot be extracted from documents using Force Specific Classification target
sheets. Do not use this type of target sheet if your firm plans to extract data for tax processing.

Note: If you select Skip AutoFlow, the file is converted to a PDF. The new PDF is placed in the
same location as the .validate file. Once the conversion is complete, the .validate file will no
longer be available for import into Tax. If you need to import the data into Tax, you can reprocess
the Scan job to generate another .validate file.

After You Scan Client Documents

Once you have scanned your client documents, you are ready to submit the documents for Scan
processing. While Scan is working with the documents, you can monitor the job's progress in Scan
Workstation. When processing is complete, you have the option of validating any data that was
extracted from the scanned documents, if any. Also, if your firm uses Tax, you can also import data
extracted from the scanned documents into a client tax return.

Viewing Job History Information

Information about completed Scan jobs displays in the History window. If needed, you can review the
information in this window to verify that a particular job completed successfully. To access the History
window, right-click a job in Scan Workstation and select History.
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The following information is recorded on the History tab for each completed Scan job:

* Time imported

* Pages imported
®* Import file

* Time exported

* Page exported

®* Export file

* Time elapsed
Note: Click on the column headings to sort the columns in ascending or descending order.

* You can only sort by one column at a time.

* When sorting within a range of dates, the sort applies within each date and is not cumulative
throughout the range of dates.

# You can sort columns based on the Setting Name.
* You can also sort data by the date range using the From and To calendar drop-down menus.

There are two summary fields that display at the bottom of the window. These are totals for the
selected Import folder during the selected date range.

* Files Imported reflects the total number of files for the selected Import folder during the
selected date range. The number in parenthesis indicates the total number of pages imported
for all Scan jobs listed, including cover pages and target sheets.

= Files Exported reflects the total number of files for the selected Import folder during the
selected date range. The number in parenthesis indicates the total number of pages exported
for all Scan jobs listed, excluding cover pages, target sheets, and blank pages.

On the History window, you can access the files in your Archive and Export folders. To access the
Archive or Export folders or files from the History window, right-click a Scan job and select one of the
following:

= Open Archive Folder. Opens the Archive folder selected on the Folder Settings tab in Scan
Administrator.

= Open Archive File. Opens the archived file.

= Open Export Folder. Opens the Export folder selected on the Folder Settings tab in Scan
Administrator.

= Send Export File to Document. Sends exported files to Document. This option is available
only if Document is installed. See the Document Help files for detailed information about
sending export file to Document.

= Open Export File. Opens the exported PDF file.
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Notes:

= Avyellow triangle with an exclamation point () next to the Scan job indicates that either the
archive or export file is missing.

= Ared circle with an exclamation point ('3) next to a Scan job indicates that both the archive and
export files are missing.

Verifying Successful Completion of a Scan Job

To verify that a Scan job processed successfully, you can do the following:

Open Scan Workstation.
2. Right-click a Scan job and select History.

3. If needed, narrow down the list of Scan jobs by using the filter fields at the top of the window.
Choose from the following filters:

= Setting Name. Select the Import folder where the Scan job originated.
= From. Enter the first date that the file may have been processed.
= To. Enter the last date that the file may have been processed.

4. Review the list of Scan jobs to verify that the processing was completed. You can compare the
page count from the original import file to the exported PDF file to ensure that no pages were
lost.

= The Files Imported totals reflect all pages, including cover pages and target sheets, in
the original file.

= The Files Exported totals reflect all pages in the original import files, excluding the
cover pages, target sheets, and blank pages that were removed.

Importing Files for Scan Processing with the Import Assistant

The Import Assistant streamlines the process of sending documents for Scan processing. With the
Import Assistant, you can move or copy scanned documents into an Import folder without navigating
through the directory structure of the Scan Administrator server.

To use the Import Assistant, do the following:

1. Do one of the following:
= |f Scan Administrator is open, click the Queue tab, and then drag the files to be
processed to the queue.
= |f Scan Workstation is open, drag the files to be processed to the Scan Workstation.

= |f neither Scan Administrator nor Scan Workstation is open, select Import Assistant
from the Start menu, and then drag the files you want to process onto the Import
Assistant window.

= |f Scan Workstation is not open, select Import Assistant from the Start menu, and then
drag the files you want to process onto the Import Assistant window.

2. Inthe Folder Setting field, select the Import folder that you want to add the files to.
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3. Do one of the following:
= Click Import to add the files to the Import folder without closing the Import Assistant.
= Click Import & Close to add the files to the Import folder and exit the window.

= Click Close to close the window without importing any files.

Note: By default, the Import Assistant moves the selected files from their location to the Import
folder. To leave the files in their original location and instead add copies to the Import folder, hold
down the Ctrl key while dragging the files. You can also use Ctrl+C to copy the files from the
Explorer window and use Ctrl+V to copy them into the Import Assistant. Use the Delete key to
remove files from the Import Assistant.

Monitoring Scan Jobs from Scan Workstation

Scan can process multiple Scan jobs at the same time. You do not have to wait for one job to
complete before submitting another job. Scan Workstation displays information about the progress of
all Scan jobs currently being processed.

You can use the information in Scan Workstation to help you plan your work. For example, if the
volume of Scan jobs is high in the morning, you can choose to send your documents for processing at
a less busy time. If you see that a job which requires immediate attention is being processed behind
other less important jobs, you can contact your system administrator to request that the job's priority
level be raised to High.

To open Scan Workstation, do one of the following:

= |f Scan Workstation is not running. Open Scan Workstation.
s |f Scan Workstation is minimized. Click the Scan Workstation icon (Z#) in the taskbar.

The following information displays for each job listed in Scan Workstation:

= Folder. The name of the Import folder where the Scan job originated.

= Priority. The priority assigned to the job. By default, the priority comes from the Import folder.
However, the Scan administrator can change the priority for a specific job, if needed.

*= Job Name. The name assigned to the Scan job. If there is a job name on the cover page, that
name is used. If a cover page is not used, or Scan cannot read the name on the cover page,
then the file name for the source file is used as the job name.

= Message. A brief description of the job's status.
= Age. The amount of time that has elapsed since the job was submitted for processing.

Searching for a Specific Scan Job

If your firm processes many documents, the list of jobs in Scan Workstation may get quite long. You
can filter the full list of jobs by searching the status listings for specific text. To do so, enter the text to

search for in the Search box ( 2 ), located at the top of Scan Workstation.
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As you type, Scan Workstation narrows the list to only display status listings that contain the text you

entered in the box. To return to the full list of jobs, click the Return button (ﬁ:').

}'[fl Tip: You can search the job list for any text that might appear in the status listing, not just by the
job name. For example, you could search for jobs from a particular Import folder.

Uploading Files to Wolters Kluwer from Scan Workstation

If Enable Files To Be Uploaded To Wolters Kluwer is selected in Scan Administrator, you can upload
problematic files to the Scan Catalog team for possible inclusion in the Scan Catalog.

You can upload your file from Scan Workstation or from the Scan Validation window.

To upload your file from Scan Workstation, do the following:

Open Scan Workstation.
Select Upload.

Select Submit Files to Wolters Kluwer. The CCH ProSystem fx Scan File Uploader window
opens.

Complete the required fields.
Provide details of your issue in the text box.

Click Select File to browse to the location of your imported file.

e -

Select the appropriate file and click Open. The attached file path displays in the
CCH ProSystem fx Scan File Uploader window.

Click Send.
9. Click OK.
10. Click Close.

Note: See Submitting a File to the Scan Catalog Team on page 46 for instructions on uploading
your file from the Scan Validation window.

Checking for Catalog Updates

To determine if you have the latest Scan catalog installed, do the following:

1. Open Scan Workstation.
2. Select Help.
3. Select Check for Catalog Update.

= |f you do not have the latest catalog installed, Catalog Update Available displays.
Follow the instructions to download the latest catalog.

= |f you have the latest catalog installed, No catalog update available displays.
4. Click OK.

Note: The catalog update must be run from the Scan Administrator computer.
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Tasks Limited to Administrators

Although you can view information about all Scan jobs in Scan Workstation, you cannot change the
processing options for a job that is in progress. If any of the following tasks must be performed for a
Scan job, see your system administrator:

® Changing the priority of a job in the queue
# Stopping or restarting a job
* Resetting Validation Lock
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Chapter 4

VALIDATING EXTRACTED DATA

Validation Overview

As a matter of best practice, you should validate data extracted from a scanned image against the
original scanned documents. If you find errors in the extracted data, you can correct them manually in
the Scan Validation window.

You can validate data:

* |Immediately following Scan processing
* While importing extracted data to a tax return using AutoFlow Wizard
& After data has been imported into a tax return

Your firm should set its own standards when validation should occur.

You do not need to have Tax installed on your workstation to validate extracted data. Validation can
be performed on any computer running Scan Workstation.

Customizing the Validation Window

You can customize the view in the Scan Validation window to make the contents of the panes easier
to read. This feature is especially useful when a scanned tax form image exhibits blurring, extra
markings, or other characteristics that can obscure text.

Changing the Font in the List of Forms and Validation Panes

1. Right-click a line of text in either of the panes and select Font.
2. Select the font characteristics that you want to apply to the window.
3. Click OK.
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Changing Image Sizes in the Validation and Scanned Tax Form Panes

L

To make the images in both panes larger, click the Zoom In button( ™ ), or right-click the Scanned

Tax Forms pane and select a higher zoom level.

To make the images in both panes smaller, click the Zoom Out button( ), or right-click the
Scanned Tax Forms pane and select a lower zoom level.

Adjusting the Sizes of Individual Panes
You can change the sizes of the panes by dragging the gray border between panes. You can also

enlarge the Scanned Tax Form pane to full page size by clicking the button that displays in the
upper-left corner of that pane. This option is only available if you have multiple monitors set up.

Validating Extracted Data with Tax Installed

You do not have to import extracted data to a tax return at the same time that you validate the data.
The procedure below describes how to validate data without performing an import. For instructions on
performing the validation and import processes at the same time, see Importing Extracted Data into
a Tax Return on page 50 for instructions.

Note: See Adding a Field or a Group of Fields for Extraction on page 44 for information about
extracting data from fields that Scan did not automatically extract data from.

To validate extracted data on a workstation with Tax installed, do the following:

1. In Scan Workstation, double-click a job marked as Ready for AutoFlow.

2. Select the Tax product that you want to import data into. If you select CCH Global fx Tax and
you have multi-account access, the system also prompts you to select an account. You can also
review the number of extracted forms and trades on this page.

3. Click AutoFlow. If you are not logged in to Tax, the system prompts you to log in. The
CCH ProSystem fx AutoFlow Wizard window displays.

Notes:

= |f you select Skip AutoFlow, the .validate file is converted to a PDF. The new PDF is
placed in the same location where the .validate file previously resided. Once the
conversion is complete, the .validate file will no longer be available for import into Tax. If
you need to import the data into Tax, you can reprocess the Scan job to generate a new
.validate file.

= |f you have CCH ProSystem fx Tax installed and select PDF with G & L only, the only
forms that will be extracted in the exported PDF file are the Gain and Loss forms. The
rest of the AutoFlow forms will not go through the AutoFlow process.

4. Click Validation. The Scan Validation window displays.
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1
l— Note: Ared exclamation point icon (g) on the Validation button indicates that an invalid

format exists in one or more forms. This data displays in the Scan Validation window with a
red exclamation point next to the form name and the field that is invalid.

The three panes in this window are as follows:
= List of Forms Pane. This pane displays in the upper-left corner of the window. It

contains a list of the tax forms where Scan extracted data. The form that is currently
selected in the Scan Validation window is highlighted in gray.

Column Description

Displays the nhame of the government form. If there are multiple forms of a

E particular type (for example, W-2 forms from multiple employers), each form
orm

name is listed separately. A red exclamation point icon (0) displays next to forms

where Scan detects potential errors. If the only potential error Scan detects
is in a blue defaulted field, the exclamation point will not display.

Displays the name of the entity that issued the form. You can use this field
Identifier to distinguish multiple forms of the same type (for example, W-2 forms from
different employers).

Action  Displays if the form is Linked, Imported New, or Skipped.

Indicates which page this form falls on in the PDF generated by Scan. If a
P form includes two pages, each page number is listed.
age
g Note: If a form includes more than two pages, the page number for the first

page of the form is listed.

E Note: There may be instances where an extractable form (for example, Form W-2)
does not show in the List of Forms pane. To display it, right-click a line in the List of
Forms pane, and then select Show all forms. The form will display on the List of
Forms pane. You can manually enter the data in the Validation pane.

= Validation Pane. This pane displays in the upper-right corner of the Scan Validation
window. It lists all the fields that were extracted from the selected form. You can correct
the extracted data in this pane as needed. If a form is skipped, the fields on the
Validation pane will appear in orange.

Column Description

Displays the fields where Scan extracted data. The field that is currently
selected for validation is highlighted in blue. A red exclamation point icon (0)

Field displays next to fields where Scan detects incorrect formats. If these fields
are not corrected, they will not be imported into Tax. If Scan detects errors in
a blue defaulted field, the exclamation point will not display.

Value Lists the values extracted by Scan. Corrections can be made as needed.

Image Displays the scanned image of the field's value.
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= Scanned Tax Form Pane. This pane displays at the bottom of the window. It displays
the scanned image for the selected form. A red box highlights the selected field. If a form
is skipped, the data extracted on the Scanned Tax Form pane displays in orange.

5. Review the field values in the Validation pane, comparing them to the scanned image. If you
see a discrepancy, click in the Value column for that field and edit the entry. Keep in mind that:

®= Changing a value in the Scan Validation window also changes the value in the
bookmarked PDF file.
®= When you edit identifying information for a tax form (for example, the employer name on
a W-2), the Identifier field and bookmark for that form are updated as well.
Press the Tab key to move to the next field.

7. Repeat steps 5 and 6 until you have reviewed all the fields on the form. Press the Tab key again
to move to the next form. Tabbing to a new form causes Scan to select the check box beside the
validated form in the List of Forms pane. The check mark indicates that you have completed
validation for that form.

8. Continue reviewing and validating until all forms are validated.
9. Click Close.
10. Since you are not importing data to Tax, click Cancel on the AutoFlow Wizard.

11. Click Yes. When Scan Workstation refreshes, the message column for the Scan job will indicate
the number of pages that were validated.

Notes:

* As jobs are validated, the Scan Workstation message changes to Validation in progress. If you
exit the Scan Validation window before validating all the forms, the Scan Workstation message
will indicate the number of pages for which validation is complete.

# |f you need to extract data for fields that were not automatically extracted by Scan, you can
select additional fields from a pre-determined list set up by Scan for extraction. For more
information, see Adding a Field or a Group of Fields for Extraction on the next page.

Validating Extracted Data Without Tax Installed

To validate extracted data on a workstation that does not have Tax installed, do the following:

1. In Scan Workstation, double-click a job marked as Ready for AutoFlow. The Scan Validation
window displays.
The three panes in this window are as follows:

= List of Forms pane. This pane displays in the upper-left corner of the window. It lists
the tax forms where data was extracted.

= Validation pane. This pane displays in the upper-right corner and lists all the fields that
were extracted from the selected form. You can correct the extracted data in this pane as
needed.
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= Scanned Tax Form pane. This pane displays at the bottom of the window when it is in
its default location. It displays the scanned image for the selected form. A red box
highlights the field that is selected.

2. Review the field values in the Validation pane, comparing them to the scanned image. If you
see a discrepancy, click into the Value column for that field and edit the entry. Keep in mind
that:

® Changing a value in the Scan Validation window also changes the value in the
bookmarked PDF file.

®= When you edit information that identifies a tax form (for example, the employer name on
a W-2), the ldentifier field and bookmark for that form are updated as well.

3. Pressthe Tab key to move to the next field.

Repeat steps 2 and 3 until you have reviewed all the fields on the form. Press the Tab key again
to move to the next form. Tabbing to a new form causes Scan to select the check box beside the
validated form in the List of Forms pane. The check mark indicates that you have completed
validation for that form.

Continue reviewing and validating until all forms are validated.

Click Close. The system displays a message asking if you want to save the validation changes.
Click Yes. The system displays a message asking if you have completed the validation.

Click Yes.

© N o o

Notes:

* As jobs are validated, the Scan Workstation message changes to Validation in progress.
= |f you must quit validation before you have reviewed all the forms, click No for step 8. The Scan
Workstation message will indicate the number of pages for which validation is complete.

* |f you need to extract data for fields that were not automatically extracted by Scan, you can
select additional fields, from a pre-determined list set up by Scan, for extraction. For more
information, see Adding a Field or a Group of Fields for Extraction below.

Adding a Field or a Group of Fields for Extraction

If you need to extract data from a field or group of fields that was not automatically extracted, you can
select additional fields by doing the following:

1. Inthe Scan Validation window, click the Add button (%) to open the Add Field window.
2. Do one of the following:
= Add afield.
a. Inthe Group list, select the name of the group that contains the field to add.
b. Inthe Field list, select the name of the field to make available for extraction.
c. Enterthe value for the field.
d. Click OK.
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= Add a group of fields.

Click the Add button (&) that is next to the Group box.

Select the group that you want to add from the drop-down box.

Click OK. You can now add fields for this group.

In the Group list, select the name of the group that contains the field to add.

In the Field list, select the name of the field to make available for extraction.

- ® o 0 T o

Enter the value for the field.
Click OK.

«

Validating Extracted Gain and Loss Transactions

To validate extracted gain and loss transactions from brokerage statements, do the following:

1. Inthe Scan Validation window, click G&L to open the Gain and Loss Validation window.
The three panes in this window are as follows:
= List of Brokerage Statements Pane. This pane displays in the upper-left corner of
the Gain and Loss Validation window. It contains a list of brokerage statements where
Scan extracted gain and loss transactions. The brokerage statement that is currently
selected is highlighted in blue. Pages with extracted trades are shown in black and pages
without extracted trades are shown in gray. You can change the size of this pane by
dragging the gray border between panes.
= Validation Pane. This pane displays in the upper-right corner of the Gain and Loss
Validation window. It lists all the trades that were extracted from the selected brokerage
statement. You can correct the extracted data in this pane as needed. You can change
the size of this pane by dragging the gray border between panes.
= Scanned Tax Form Pane. By default, this pane displays at the bottom of the Gain and
Loss Validation window. It displays the scanned image for the selected brokerage
statement. A red box highlights all the extracted data. A blue box highlights the data that
is selected. You can enlarge this pane by double-clicking it. This option is only available if
you have multiple monitors set up.
Find the page that contains the Total for the brokerage statement.
Compare the Brokerage Statement Total with the Calculated Total displayed on the first row.

If the totals match, proceed to the next step. If the totals do not match, click Insert Total. This
will automatically insert a Statement Total row below the Calculated Total row. Using the
totals found in the brokerage statement, enter the following in the Statement Total row:

®= Sales price

= Cost

* \Wash sale

* Extracted G&L
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5. Review the field values in the Validation pane. Conflicts are highlighted in yellow to easily
identify which trades need to be reviewed. Make all necessary changes until all conflicts are
resolved.

Notes:

= Click Previous Conflict and Next Conflict to easily navigate through all the conflicts in
the brokerage statement.

= |f the Description, Sold Date, or 1099-B Code is missing, a red triangle displays on the
top-right corner of the cell indicating that it is Copied from trade above.
®= Fields that are calculated and copied from trade above are highlighted in gray.

6. If there are any rows that did not extract, click Insert Row. Enter the following:
®= Description
= Shares
® Sales price
* Cost
Acquired date
Sold date
Wash sale (if any)
Extracted G&L
®= 1099-B code

Note: Calculated G&L calculates automatically based on sales price, cost, and wash sale.

7. If there are any rows that extracted by error, click Delete Row.

8. Once all conflicts have been resolved and all brokerage statements have been validated, click
Close to close the Gain and Loss Validation window.

Submitting a File to the Scan Catalog Team

You can email or upload your files to the Scan Catalog team if the option to do so is enabled in Scan
Administrator. The instructions below describe how to submit files from the Scan Validation window.
See Uploading Files to Wolters Kluwer from Scan Workstation on page 38 for instructions on
uploading your file from Scan Workstation.

Emailing a File

If Enable Files To Be Emailed to Wolters Kluwer is selected in Scan Administrator, you can submit
your files to the Scan Catalog team via email.

To email a file, do the following:

1. Onthe Scan Validation window, select Email Import File to Wolters Kluwer (-1). Your default
email opens. The file you are validating is attached as an encrypted file.
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2. Enterthe necessary information on the body of the e-mail.

3. Select Send. You will receive an acknowledgment email once the file is sent to Scan.

Note: Yourimported file can also be directly emailed to the Scan Catalog team at
Scancatalog@wkglobal.com. This file can be located in your Archive folder at C:\ProSystem fx
Scan\ProSystem fx Scan Shared\Archive.

Uploading a File

If Enable Files To Be Uploaded To Wolters Kluwer is selected in Scan Administrator, you can upload
your files to the Scan Catalog team. You can upload your file from Scan Workstation or from the Scan
Validation window.

To upload a file, do the following:

1. On the Scan Validation window, select Upload File to Wolters Kluwer (@). The
CCH ProSystem fx Scan File Uploader window opens.

2. Complete the required fields.

3. Provide details of your issue in the text box.

4. Click Select File to browse to the location of your imported file.
5. Select the appropriate file and click Open.

6. Click Send.

7. Click OK.

8. Click Close.
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Chapter 5

INTEGRATING WITH OTHER WOLTERS
KLUWER PRODUCTS

Integrating with Tax

You can use AutoFlow Wizard to validate and import extracted data from the following forms into Tax:

Forms for a 1040 Return

1095-A 1099-INT K-1(1120S)
1095-B 1099-MISC SSA-1099
1095-C 1099-Q W-2
1098 1099-R W-2G
1098-E 1099-SA Combined Tax
Statement
1098-T 2439 Gain and Loss
Statement
1099-DIV K-1(1041)
1099-G K-1(1065)
Forms for a 1041 Return
1099-DIV 2439 K-1(1120S)
i T
1099-INT K-1 (1041) Combined Tax
Statement
1099-R K-1(1065) Gain and Loss

Statement

You can also use AutoFlow Wizard to generate a PDF file from an AutoFlow file.
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Note: If you plan to export data to a client's tax return, before you scan the source documents,
ask the system administrator whether the Import folder for the Scan job is set to allow data
extraction. If not, you must use an extraction cover page for the Scan job.

Extracting Gain and Loss Statements Only

Scan can extract gain and loss data with no other extractable forms in a file.

Note: This feature is only available if you have CCH ProSystem fx Tax installed. This feature is
not currently available for CCH Global fx Tax or CCH Axcess Tax customers.

To extract data for gain and loss statements only:

Scan and submit your documents for AutoFlow.

2. Open Scan Workstation. Scan jobs that display Ready for AutoFlow in the Message column are
available for you to process.

Double-click a Scan job containing the data you want to import.

Select CCH ProSystem fx Tax. You can also review the number of extracted forms and trades
on this page.

5. Click PDF with G & L only to continue with the extraction process. If you are not logged in to
Tax, the system prompts you to log in. The CCH ProSystem fx AutoFlow Wizard window
displays. The information on this screen includes the following:

= Extracted AutoFlow Clients. Lists taxpayer dentification numbers found in the
scanned documents along with the names of taxpayers associated with those
identification numbers.

= Tax Clients. Lists tax returns for a selected year that are potential matches for the
names listed in the top section of the window. AutoFlow Wizard uses taxpayer
identification numbers to match the scanned documents with existing tax returns.

Notes:

= Data will only be displayed if there are other extractable forms besides the Gain and Loss
statements in your file.

= |f you select PDF with G & L only, the Gain and Loss data will be the only data
extracted in the exported PDF file. If additional AutoFlow forms exist in this file, they will
not be extracted. If you would like to AutoFlow all extractable forms in this file, click
AutoFlow to continue with the AutoFlow process.

= |f you select Skip AutoFlow, the validate file is converted to a PDF file. The new PDF
file is placed in the same location where the validate file previously resided. Once the
conversion is complete, the validate file will no longer be available forimport into Tax. If
you need to import the data into Tax, you can reprocess the Scan job to generate a new
validate file.
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6. Select the tax return to flow data to in the Tax Clients list. If the return you need is not listed, you
can do the following to identify it:

* |nthe Client ID/Taxpayer ID # box, enter either the client ID number or taxpayer
identification number associated with the return you need, and then click Search. If
the system finds a return matching the client ID number or taxpayer identification
number, the return is listed in the Tax Clients section.

® Create and select a new tax return.

i. Click New Tax Return.
ii. Create and save a new tax return. See the Tax help files for instructions on
creating a new return.
iii. Save and close the return.
iv. Return to the AutoFlow Wizard.
v. Click Refresh.
vi. Select the new return in the Tax Clients list.
7. Review the information on this window. Select or clear the following items as needed:

= Save annotations for items. The Scan-generated PDF file contains annotations
indicating which fields were imported to the return and which were skipped. Clear this
box if you do not want these annotations to be saved.

= Add File to CCH Axcess Document or CCH ProSystem fx Document (On-
Premise). Select this box to upload the file to Document. This option is only available if
Document is installed. See the Document Help files for detailed information about
sending export files to Document.

8. Click Finish.
9. Click OK.

When the process completes, the .validate file is converted to a PDF file and saved to the location
where the validate file resided before you performed the AutoFlow process. The PDF file includes the
extracted data, as well as the gain and losses information in an Excel spreadsheet. If you select
Export G&L Transaction to a PDF in Scan Administrator, a PDF that contains the brokerage statement
pages with gain and loss transactions will also be included in the PDF file.

Importing Extracted Data into a Tax Return

To streamline the process of importing extracted data into a tax return, AutoFlow Wizard tries to
match scanned documents with existing tax returns. It does this by comparing taxpayer identification
numbers in the scanned documents with taxpayer identification numbers in returns. If Scan doesn't
find a return that matches the extracted data, you can launch Tax from AutoFlow Wizard to create a
new return. You must have access rights to a tax return to be able to AutoFlow data to the return.

}5 Tip: For best results, we recommend that you validate extracted data against the scanned
documents before importing the data into a tax return. For more information about validation, see
Validation Overview on page 40.

Chapter 5 - Integrating with Other Wolters Kluwer Products « 50



To import extracted data into a tax return:

1.

Open Scan Workstation. Scan jobs that display Ready for AutoFlow in the Message column are
available for you to process.

Double-click a Scan job containing the data you want to import.

Select the Tax product that you want to import data into. If you select CCH Global fx Tax and
you have multi-account access, the system also prompts you to select an account. You can also
review the number of extracted forms and trades on this page.

Click AutoFlow. If you are not logged in to Tax, the system prompts you to log in. The
CCH ProSystem fx AutoFlow Wizard window displays. The information on this screen includes
the following:

= Extracted AutoFlow Clients. Lists taxpayer identification numbers found in the
scanned documents, along with the names of taxpayers associated with those
identification numbers.

= Tax Clients. Lists tax returns for a selected year that are potential matches for the
names listed in the top section of the window. AutoFlow Wizard uses taxpayer
identification numbers to match the scanned documents with existing tax returns.

Notes:

= |f you select Skip AutoFlow, the .validate file is converted to a PDF file. The new PDF is
placed in the same location where the .validate file previously resided. When conversion
is complete, the .validate file is no longer available for import into Tax. If you need to
import the data into Tax, you can reprocess the Scan job to generate a new .validate file.

= |f you have CCH ProSystem fx Tax installed and select PDF with G & L only, the only
forms that will be extracted in the exported PDF file are the Gain and Loss forms. The
rest of the AutoFlow forms will not go through the AutoFlow process. For more
information, see Extracting Gain and Loss Statements Only on page 49.

= |f Scan detects an iterative form (a form that includes multiple line items, but no total
line), this will be displayed in the upper right corner. Although not required, we
recommend that you validate iterative forms before continuing. To validate iterative
forms, click Iterative Validation in the upper-right corner of the window. This is
recommended because:
= Prior to import, AutoFlow Wizard considers the individual line items as part of
the same form. If you edit data that is common to all of the line items (for
example, the issuer name), the edits are applied to all of the line items. Once
you select Next, the individual line items are broken into separate forms. If the
common data requires edits after the split, then the form for each line item must
be edited individually.
= |f you need to change the bookmark that will display in the final PDF file, the
issuer name field (which is used for the bookmark) must be edited before the
line items are split into individual forms. Editing the issuer name field after the
form is split will not change the bookmarks in the final PDF file. However, these
edits will be reflected in Tax if you import the data into a return.
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5. If needed, you can validate the extracted data before continuing with the AutoFlow process. See
Validating Extracted Data with Tax Installed on page 41 for detailed instructions.

6. To display returns for a different year in the Tax Clients list, select the tax year from the tax year
list. Only tax years for which you have Tax installed are available.

7. Select the tax return to flow data to in the Tax Clients list. If the return you need is not listed, you
can do the following to identify it:

* |nthe Client ID/Taxpayer ID # box, enter either the client ID nhumber or taxpayer
identification number for the return you need, and then click Search. If the system
finds a matching return, the return is listed in the Tax Clients section.

* Create and select a new tax return.
i. Click New Tax Return.
ii. Create and save a new tax return. See the Tax Help files for instructions.
iii. Save and close the return.
iv. Return to the AutoFlow Wizard.
v. Click Refresh.
vi. Select the new return in the Tax Clients list.
8. Click Next to display a list of the forms where AutoFlow Wizard has extracted data. The forms
are grouped as follows:
* Linked forms imports into an existing form in the tax return when you click Finish.
= |mported New forms creates a new input form in the tax return when you click Finish.
= Skipped forms are not imported into the tax return unless they have been updated to
Import New or Link. An orange icon (-*”-) displays next to skipped forms. A tool tip is
added to the icon explaining why the form was skipped.
9. Do any of the following as necessary to prepare the data for import into the return:
®= Review the contents of a form before deciding whether to import it to the return.
i. Select the form in the list.

ii. Click Review. The Review Tax Forms window displays. In this window, you can
select to perform any of the following actions on the form:

- Link the document to one already in the tax return. Select Link, and
then select the entity to link the document to. If there are no matching
documents in the return, this option is disabled.

= Import the document as a new form. Select Import New, and then
select the taxpayer the form belongs to.

= Skip the form during extraction. Select Skip. If needed, you can add a
note about why the form was skipped. No data from the form will be
imported to Tax when this option is selected.

iii. If needed, clear the Overwrite Default Issuer Information in Tax box to
prevent the Issuer/Payer information in the form from replacing the information
already in Tax.
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iv. If needed, select Overwrite Default Recipient Information in Tax. When you
select this box, the data in the Recipient area of the form will replace the default
data already in Tax.

v. If needed, click Form Validation to review the information on the form. See
Validating Extracted Data with Tax Installed on page 41 for instructions.

vi. Click Close when you are done reviewing the form.
vii. Click Close to exit the Review Tax Forms window.
= Select a skipped form to be imported to the return
= Import a skipped form to a new form
i. Select the form in the list.
ii. Click Import New.

ii. Click Yes if the system asks if you want to import unknown taxpayers to
the return. If the taxpayer identification number matches but was skipped,
you will not receive this warning.

= Link a skipped form to an existing form
i. Select the form in the list

ii. Click Review.

iii. Select Link, and then select the entity to link the document to.

iv. Click Close to exit the Review Tax Forms window.

Note: If there are no matching documents in the return, this option is
disabled.

10. Click Next when you have reviewed all of the forms and are ready to continue the import.

11. Review the information on the Tax Import Summary window. Select or clear the following items
as needed:

= Save annotations for items. The Scan-generated PDF file contains annotations
indicating which fields were imported to the return and which were skipped. Clear this
box if you do not want these annotations to be saved.

= Add File to CCH Axcess Document or CCH ProSystem fx Document (On-
Premise). Select this box to upload the file to Document. This option is only available if
Document is installed. See the Document Help for more information about sending files
to Document.

12. Click Finish.
13. Select Yes if you are prompted to apply an authorization.
14. Click OK.

When the import completes, the .validate file is converted to a PDF file and saved to the location
where the .validate file resided before you performed the AutoFlow process. The PDF file includes the
extracted data, as well as the gain and losses information in an Excel spreadsheet. If you select
Export G&L Transaction to a PDF in Scan Administrator, a PDF that contains the brokerage statement
pages with gains and loss transactions will also be included in the PDF file.
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Reviewing AutoFlow Diagnostics, the Gains and Losses Spreadsheet, and the
Gains and Losses PDF

After data is imported into a return, the following three icons display on the first page of the PDF file:

Double-click this icon to open a spreadsheet containing information from the Tax Import
@. Summary window. The spreadsheet lists forms that are linked, imported new, skipped, and

missing. It also includes a list of invalid fields. This embedded spreadsheet is a record of the

AutoFlow process, and is available along with other digital documents for the client.

If a file contains a gain and loss statement, AutoFlow Wizard automatically creates a
spreadsheet with this information. Double-click this icon to open the spreadsheet containing all
the gain and loss transactions that were extracted during the AutoFlow process. This
spreadsheet is used to import the gain and loss transactions to Tax. This embedded
spreadsheet is available with other digital documents for the client.

If Export G&L Transaction to a PDF is selected in Scan Administrator and a file contains a gain
and loss statement, AutoFlow Wizard automatically creates a PDF that contains the brokerage

@ statement pages with gain and loss transactions. Double-click this icon to open the PDF
containing the brokerage statement pages with gain and loss transactions. If you do not want to
import the gain and loss transactions to Tax, you can attach this PDF to the tax return. This
embedded PDF is available with other digital documents for the client.

Importing Gain and Loss Transactions

If a file contains gain and loss statements, the number of trades extracted displays on the Tax Import
Summary window. This information also displays on the first page of the AutoFlow Wizard. The
number of trades displayed comes from each line that is extracted from the gain and loss statements.

If an extracted trade contains no description, Scan duplicates the description from the previous trade
line.

Note: A comment is added to the spreadsheet indicating that the item's description was Copied
from trade above.

When a trade is extracted and only a day and month exist for the Sold Date, AutoFlow Wizard displays
the year in the gains and losses spreadsheet based on the current year used in AutoFlow (for
example, if 2015 is selected in AutoFlow Wizard as the year for the Tax Client, 2015 also displays as
the Sold Date).

Note: Acomment, Review year, is added to the cell if the year you selected in AutoFlow Wizard
is not the current year.

If a year is missing from the Acquired Date, then that date is not extracted and is displayed as a blank
cell in the gains and losses spreadsheet.

If the Sold Date is missing, AutoFlow Wizard copies the Sold Date from the previous trade line that
was extracted. A comment displays in the cell indicating that it was Copied from trade above.
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If one of the following words displays in the Acquired or Sold Date field, Scan converts them to
99/99/99 on the spreadsheet:

* Various

* Unknown

= N/A

= Multiple

* Please provide

®# Unavailable

®* Earnings
Scan displays the description of each trade first, followed by the number of shares.

Scan adds a border line in the gains and losses spreadsheet for each brokerage statement bookmark
in the PDF file. This allows you to see where each brokerage statement starts and ends.

To make changes to the spreadsheet, do the following:

1. Open the PDF file.
2. Do the following to save the attached spreadsheet to your computer:

a. Right-click the attached Excel spreadsheet.

b. Select Save Attachment.

c. Select the location where you want to save the file, and then click Save.
3. Review the spreadsheet and make any necessary changes.

4. Import the gains and losses data to Tax. For instructions on importing gains and losses data to
Tax, see the Tax help files.

Using Annotations to Color Code Data in a Return

You can keep track of which fields in a Scan-generated PDF file were successfully imported into a tax
return. The color of an annotation indicates whether the highlighted data was imported to a tax return.

The colors used for the annotations are:

Annotation Meanin
Color 9
Green The data was extracted and imported to a tax return.
Blue The data was extracted, but not imported to a tax return. Instead, the Tax defaults were

used in the return.

The data was extracted, but an error in the field prevented the data from being imported
Red to Tax. An example of data that might cause a field error is a taxpayer identification
number field with too few digits.

Orange Data was extracted, but there was not a place in the return to import the data to.

To enable annotations, select Save annotations for items on the Tax Import Summary window
when you run AutoFlow Wizard.
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To display annotations in the Scan Validation window:

1. Link the scan to a tax return.
2. Click Next.
3. Select Validation. The annotations display on the Scan Validation window.

To turn off the commenting balloons on your PDF file in Adobe® Acrobat®:

Open the PDF file from the Export folder.
Select Edit > Preferences.

Select Commenting from the Categories pane.

M wbd =

In the View Comments section, clear the Enable text indicators and tooltips box.

Integrating Scan with Document

If your firm uses Document, Scan can publish the PDF files it generates directly to Document. Staff
members at the firm can then retrieve the bookmarked PDF files from Document just as they would
any other documents.

The workflow for using Scan with Document is the same as the typical Scan workflow, except that you
should use a Document routing slip in place of a Scan cover page. Scan uses the barcode on the
routing slip to determine the name of the bookmarked PDF file and to route the completed document
to the correct client. The routing slip is not included in the final PDF file generated by Scan.

Notes:

* To integrate Scan with Document, your system administrator must set up the Scan folder in
Document that will be the Export folder for Scan. If you are unsure which Import folder to use for
Document, consult your system administrator.

# |f you use a Document routing slip, you should not also use a Scan cover page. Doing so will
cause an error in Scan.

Note: The option to add your return to Document displays only if Document is installed on your
system.

Setting Up Document Folders for Use with Scan

The process required to set up Scan folders depends on which version of Document you are using.

= CCH ProSystem fx Document (On-Premise), version 4.0 and newer. By default, the
system monitors the Pfx Document/Scan folder for newly added PDF files. If you need to
configure Document to monitor additional folders, you can do so in Document's Routing
Settings window.

= CCH ProSystem fx Document, versions 3.9 and older. Open the Administrator Home
Page and click Scan Folders on the Manage section of the navigation bar to display the Scan
Folder window.
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= CCH Axcess Document. By default, the system monitors the CCH Axcess Document/Scan
folder for newly added PDF files. If you need to configure Document to monitor additional
folders, you can do so in Document's Routing Settings window.

See the Document Help files for detailed information about setting up your Scan folders for
Document.

Setting Up Scan for Use with Document

Before you can use Scan with Document, you first must set up Scan folders in Document, and then
perform the following procedure:
1. Open Scan Administrator.
Click the Folder Settings tab.

3. Use the default folder settings name, or click Add New to create a new Import folder specific to
Document.

Note: A new folder path must be created for each company you have in Document.

Enter the Scan folder path that you set up in Document in the Export Folder field.
Configure the other settings for the Import folder as needed.
Click Save.
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Chapter 6

WORKING WITH PDFLYER

PDFlyer Tools

By default, the PDFlyer tools display on the Adobe® Acrobat® menu bar and tools pane with the other
Adobe® Acrobat® tools. You also can add PDFlyer tools to the Quick Tools toolbar. By doing this,
PDFlyer icons will display on the toolbar and will give you another way of quickly accessing the
PDFlyer tools.

The PDFlyer Stamps tools display separately. This allows the stamps (connectors, tickmarks,
favorites, and User stamps) to be positioned independently of the functions on the PDFlyer tools.

Each of the PDFlyer tools is discussed in the following sections.

Rotating Pages

3 Rotate Counterclockwise @ Rotate Clockwise

Individual pages in a PDF file can be rotated by 90 degrees counterclockwise or clockwise using the
Rotate tools. These tools differ from the standard Adobe® Acrobat® Rotate tool, which rotates the
entire document when selected. Only the active page in the PDF is rotated when the Rotate tool is
selected from the PDFlyer tools. When the PDF file is saved, the rotated page is saved in the desired

orientation.

Inserting PDFs
w

Insert PDF

Use Insert PDF to add documents to an existing PDF file, even if it was scanned or printed to PDF
format from another application. This tool assists with the inclusion of late-arriving documents in the

original bookmarked PDF file.
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By default, Acrobat® places all incoming pages and bookmarks at the end of the receiving PDF file.
You would have to manually drag the bookmarks or pages under the correct parent bookmark. With
PDFlyer, parent bookmarks are analyzed and child bookmarks are combined under the same parents
automatically.

To insert PDFs into an existing PDF file, do the following:

1. Convert the pages to be added into PDF format. If you are scanning, direct the scanned output
to the location where you normally scan your non-Scan documents.

Note: Multiple new items for a given client can be converted to PDF and scanned at the
same time (for example, brokerage statements or revised K-1).

Open the PDF file to which the pages are to be inserted.

3. Select the position in the currently open PDF file where you would like the new pages to be
inserted by highlighting the bookmark.

4. Click the Insert PDF tool from the PDFlyer tools to display the Please select a file to insert
window.
Browse to locate the incoming PDF file you want to insert.
Click Open or double-click the file name to display the Insert PDF window.

7. If the incoming PDF file is bookmarked, Merge PDF page(s) based on parent level
bookmarks is selected by default. This option merges the two PDF files, combining child
bookmarks under the same parent bookmarks. The PDF is repaginated based on the location of
the inserted PDF.

8. Select Append PDF page(s) as a single bookmark if the incoming PDF file is not
bookmarked and you want to append it as a single bookmark. If you select this option, you can
select the bookmark level to use:

= Same level as the highlighted bookmark

® Child of the highlighted bookmark

®= Parent level at the end of the PDF
The Bookmark Name displays as the name of the incoming PDF file. You can change the
bookmark name if needed. You can also choose to automatically create a unique bookmark for
each page by selecting the Create a bookmark for each page check box.

9. Select Append PDF page(s) without a bookmark if you want to append the incoming PDF
file without a bookmark. Options include Append to the highlighted bookmark, or Append
to the end of the PDF.

10. Click OK. Your file is inserted or merged into the existing document, at the location you
selected.
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Inserting Target Sheets

Insert Target Sheets
When PDFlyer is used with Scan, use Insert Target Sheets to indicate where to create a bookmark.

To insert a target sheet, do the following:

1. Click the Insert Target Sheets tool from the PDFlyer tools to display the Insert Target Sheets
window.

2. Select a page number where you want to insert a target sheet.
Click Insert Single Page if you want to insert a Single Page Target Sheet. Click Insert Multi-
Page if you want to insert a Multi-Page Target Sheet. The target sheet displays above the
selected page number.

To remove a target sheet added in error, select the target sheet in the list and click Remove.
5. Click OK. The PDF is repaginated based on the location of the inserted target sheets.

Exporting to a Multi-Page TIFF

| Export to Multi-Page TIFF
Use Export to Multi-Page TIFF to export or convert a PDF file to a Multi-Page TIFF file.
To export to a multi-page TIFF file, do the following:
1. Click the Export to Multi-Page TIFF tool from the PDFlyer tools to display the Save As

window.
Browse to the location where you want to save the file. Rename the file if needed.

Click Save. A progress bar displays, indicating the progress of the export. When the export is
complete, the progress bar no longer displays.

4. Once complete, browse to the location where you saved the multi-page TIFF file and open the
file to view the results.

Note: Annotations, tickmarks, and calculator tapes from the PDF are displayed in the TIFF file.
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Deleting Bookmarks

r% Delete Bookmark

This tool enforces integrity between a bookmark and its associated pages. In Adobe® Acrobat®, a
bookmark can easily be detached from a page. Detached bookmarks are called orphans and result in
clicking on a bookmark that does not take you anywhere, or being unable to easily find a page that
was at one time bookmarked.

Do not delete empty parent bookmarks. Instead, use Hide Empty Bookmarks from the Bookmark
Options drop-down menu.

To delete a bookmark and its associated pages, do the following:

Select the bookmark to be deleted.

2. Click the Delete Bookmark tool on the PDFlyer tools to display the Delete Bookmark window.
A message asking you to confirm your deletion displays. PDFlyer automatically determines the
pages to be deleted and indicates this in the message.

3. Click Yes to delete the bookmark and its associated pages, or click No to cancel.

I wa rning! There is no way to retrieve pages once they have been deleted.

Deleting Pages
Q

Delete Page

Delete Page deletes only the active page. When deleting a page, keep the following in mind:

* |f the deleted page is a single page attached to a bookmark, the associated bookmark is also
deleted.

* |f the deleted page is a bookmarked initial page of a multi-page document, the bookmark is
automatically attached to the next page of the document.

* |f the deleted page is a non-bookmarked page of a multi-page document, only the page is
deleted.

! Warning! You should not use the Delete Page tool when a bookmark selected is a parent
bookmark that is not specifically attached to a page. You cannot recover deleted pages, so use
this feature with caution.
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Splitting Bookmarks

[———]

Split Bookmark

Split Bookmark allows you to take a multi-page bookmark and split it into separate smaller
bookmarks. Use this tool to create new bookmarks and assign pages to the new bookmarks without
having to rely on the Pages tool in Acrobat®.

To split a bookmark, do the following:

1.

Select the multi-page bookmark to split (divide). You cannot select multiple bookmarks at the
same time. Instead, select one bookmark at a time.

Click the Split Bookmark tool on the PDFlyer tools to display the Split Bookmark window. If the
bookmark is a single-page bookmark, an orphan bookmark (which does not point to any pages),
or contains child bookmarks, a message displays telling you that Split Bookmark cannot be
performed.

Split Bookmark tracks the range of pages for the selected bookmark. The selected page displays
behind the Split Bookmark window.

Select the page for the new bookmark and click Add New Bookmark. The new bookmark
name defaults to New Bookmark and displays above the selected page number. To change the
default name, enter it on the space provided. The corresponding number of pages is displayed
next to the new bookmark. The original bookmark name remains the same with the updated
corresponding number of pages that apply to that bookmark.

Use the Move Page(s) Up and Move Page(s) Down to move pages from the original
bookmark to the new bookmarks. To move multiple pages at the same time, press the Ctrl or
Shift key while selecting the pages.

To remove a bookmark added in error, select the bookmark in the list and click Remove
Bookmark. PDFlyer always retains one bookmark in the list. You cannot remove all bookmarks
using this tool. The Remove Bookmark button is only available when a bookmark is selected.

To rename a bookmark in the list, select the bookmark and click Rename Bookmark.

Once you have added all new bookmarks and assigned pages, click OK. If you did not assign
pages to a bookmark, this empty bookmark is deleted automatically. Make sure you assign
pages to all bookmarks you want to keep. New bookmarks are created at the same level as the
original bookmark.
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Setting Bookmark Options

:_l Bookmark Options

Click the Bookmark Options list.

GIE Bookmark Options

Expand All Baokmarks
Collapse All Bookmarks
"_"[3 Colorize/Uncolorize Bookmarks
, Hide Empty Bookmarks
Show Empty Bookmarks

Use options from this tool to manipulate bookmarks in the following ways:

* Expand All Bookmarks

# Collapse All Bookmarks

® Colorize/Uncolorize Bookmarks

* Hide Empty Bookmarks (hides empty Parent bookmarks in PDF files generated by Scan)

®* Show Empty Bookmarks (shows empty Parent bookmarks in PDF files generated by Scan)

:_l Colorize/Uncolorize Bookmarks

The bookmarks in a PDF file can be colorized using the Colorize/Uncolorize Bookmarks tool.

Colorizing bookmarks gives you a quick way to determine which parent-level bookmarks are populated
or unpopulated, and to quickly distinguish the different levels of bookmarks from one another.

Following are the default colors used to colorize bookmarks. To change the colors for unpopulated
parent bookmarks (empty bookmarks) and unpopulated child bookmarks (non-empty bookmarks),
select Bookmarks from the Settings tool. See Configuring Settings on page 75 for additional
information.

= Light Gray. Unpopulated parent-level bookmarks

= Black. Populated parent-level bookmarks

#= Blue. Unpopulated child-level bookmarks
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Using the Calculators

PDFlyer includes a 10-key calculator and a basic calculator that produce an electronic calculator tape
and can be attached to a PDF file. Both the 10-key calculator and the basic calculator display in the
PDFlyer tools by default. To change this selection, select Calculator from the Settings tool.

Using the Calculator Tape

The calculator tape is placed on the upper left corner of the active page by default. You can drag it to
a different location on the page if needed.

To change the tape color, text color, and text size on the calculator tape, select Calculator from the
Settings tool. Changing the font size may be useful when the tape is too long to fit on a short form or
slip.

To rotate the calculator tape, right-click on the tape and select either Rotate Tape Clockwise or
Rotate Tape Counterclockwise.

To link the calculator tape to other pages on the PDF file or markup the calculator tape, add a
connector or tickmark on the calculator tape itself.

Editing Calculations

Calculations are grouped into sections. A hew section begins when a total or grand total is calculated
for each section. You can enter a title on the first line (i.e. 1-0) of each section and additional notes on
the remaining lines by double-clicking on the space in the Note column.

If you enter an incorrect number or operator, you can double-click on the number or operator to edit it.
If the total for the section is already calculated, the total is recalculated based on the edited number or
operator.

Note: For the 10-key calculator, if you replace an addition (+) or subtraction (-) operator with a
multiplication (x) or division (+) operator, the total will not include the numbers with the
multiplication (x) and division (+) operators. Remember that multiplication (x) and division (+)
operators require the equals (=) to calculate the total.

If you forget an item and need to add it in the calculator tape, highlight the line where it should be
added and click Add Line. The new line is added above the highlighted line. To delete a line,
highlight the line you want to delete and click Delete Line.

To edit the calculator tape that is already on the PDF, double-click the calculator tape. You can also
right-click on the calculator tape and select Edit Tape. It automatically displays on the calculator and
it is available for edit. You can then make all the necessary changes and send it back to PDF. The
calculator tape on the PDF automatically updates with your changes.
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Using the PDFlyer 10-key Calculator

To open the 10-key calculator, click the PDFlyer 10-key Calculator tool on the PDFlyer tools. Each
of the calculator button is described below:

Clear Buttons

= Backspace <Backspace> Clears the digit (clears from right to left)
C Clear <Esc> Clears all incomplete calculation
CE Clear Entry <C> Clears the number on the display

Function Buttons

Change of i
+/- . ¢ <S> Changes the sign of the number
Sign Entry
Calculates the percentage of the previously entered
% Percentage <%> P o P y
number
F Decimal <D> Allows to select how many decimal places to display
Date Add Date &
. ) <T> Inserts a date and time on the Note column
Time Time
GT Grand Total <Enter> Calculates the total of all set of calculations
Calculates the subtotal of the current set of calculation
¢ Subtotal <Space> . .
and continues with that set
* Total <Enter> Calculates the total of the current set of calculation
Add . . . .
Line Add New Line  <Insert> Inserts a line on an existing set of calculation
Delete  Delete Current . L .
. . <Delete> Deletes a line from an existing set of calculation
Line Line
New Clear Current
Clears the tape and starts a new one
Tape Tape
Print Tape to
To PDF PDE P Prints the tape to the PDF file
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Keypad Buttons

0-9 Numeric Inserts the numeric digits 0 - 9
00 Double Zeroes Inserts two 0’s
000 Triple Zeroes Inserts three 0’s

Decimal Inserts a decimal

Memory Buttons

MC Memory Clear <G> Clears the number stored in memory

MS Memory Store  <H> Stores the number on the display in memory

MR Memory <J> Recalls the number stored in memory and inserts it into
Recall the display

M Memory K> Subtracts the number on the display from the number
Subtract currently in memory

M+ Memory Add > Adds the number on the display to the number currently

in memory

Operator Buttons

Adds two or more numbers

+

_ Add <+> Calculates the total of x and + and continues with the
addition process
Subtracts two or more numbers

_ Subtract <> Calculates the total of x and + and continues with the
subtraction process

x Multiply <> Multiplies two or more numbers

& Divide </> Divides two or more numbers
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Below are some examples on how to enter operations on the 10-key calculator:

Calculation Operation Calculator Tape
25+50=75
1-0
25 + 1-1 25 +
50 + 1-2 50 +
* 1-T Total 75 *
75-25=50 1-0
75 + 1-1 75 +
25 - 1-2 25 -
* 1-T Total 50 *
25+50-30=45
1-0
25 + 1-1 25 +
50 + 1-2 50 +
30 - 1-3 30 -
* 1-T Total 45 *
2x3=6 1-0
2 X 1-1 2 X
3 1-2 3 =
1-3 6 T
6+3=2 1-0
6 + 1-1 6 +
3 1-2 3 =
1-3 2T
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-2x3=-6 1-0
2 +/-x 1-1 2 X
3 - 1-2 3 =
1-3 6 T
(2x3)+4=10 1-0
2 x 1-1 2 X
3 + 1-2 3 =
13 6 T
14 6 +
4 + 1-5 4 +
¥ 1-T Total 10 *
500x10%=50 1-0
500 x 1-1 500 x
10 % 1-2 10 %
1-3 50 T
100+200=300 1-0
+400+500=900 | 100 + 1-1 100 +
1200 | 200 + 1-2 200 +
* 1-T Total 300 *
2-0
400 + 2.1 400 +
500 + 22 500 +
* 2-T Total 900 *~
GT GT Grand Total 1200 *
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Memory Calculation Operation Calculator Tape
100+200=300 1-0
+400+500=900 | 100 + 1-1 100 +
1200 | 200 + 1-2 200 +
* 1-T Total 300 *
MS
2-0
400 + 2-1 400 +
500 + 2-2 500 +
* 2-T Total 900 *
M+
MR
30
+ 3-1 1200 +
* 3-T Total 1200 *
MC
400+500=900 1-0
-100+200=300 | 400 + 1-3 400 +
600 | 500 + 14 500 +
* 1-T Total 900 *
MS
2-0
100 + 2-1 100 +
200 + 2-2 200 +
* 2-T Total 300 *
M-
MR
3-0
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MC

3-1

3-T Total

600 +

600 *

i Using the Basic Calculator

The basic calculator works like a regular calculator, with the capability of producing an electronic
calculator tape that can be attached to a PDF file.

To open the calculator, click the Basic Calculator tool on the PDFlyer tools. Each of the calculator

buttons is described below:

Clear Buttons

= Backspace <Backspace> Clears the digit (clears from right to left)
C Clear <Esc> Clears all incomplete calculation
CE Clear Entry <C> Clears the number on the display

Function Buttons

Change of Sign

+/- <S> Changes the sign of the number
Entry
Calculates the percentage of the previously entered
% Percentage <%> P g P y
number
F Decimal <D> Allows to select how many decimal places to display.
Date Add Date &
. . <T> Inserts a date and time on the Note column
Time Time
Add . . . .
Line Add New Line <Insert> Inserts a line on an existing set of calculation
Delete Delete Current . - .
. . <Delete> Deletes a line from an existing set of calculation
Line Line
New Clear Current
Clears the tape and starts a new one
Tape Tape
Print Tape to
To PDF PDF P Prints the tape to the PDF file

Chapter 6 - Working with PDFlyer « 70



Keypad Buttons

0-9 Numeric Inserts the numeric digits 0 - 9
00 Double Zeros Inserts two O’s
000 Triple Zeros Inserts three 0’s

Decimal Inserts a decimal

Memory Buttons

MC Memory Clear <G> Clears the number stored in memory
MS Memory Store <H> Stores the number on the display in memory
MR Memory Recall  <J> Recallls the number stored in memory and inserts it into
the display
M Memory <K> Subtracts the number on the display from the number
Subtract currently in memory
M+ Memory Add <> Adds the number on the display to the number

currently in memory

Operator Buttons

& Add <+> Adds two or more numbers

- Subtract <> Subtracts two or more numbers

x Multiply <> Multiplies two or more numbers

+ Divide </> Divides two or more numbers

= Equals <=> Calculates the total of x and + functions only
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Below are some examples of how to enter operations on the basic calculator:

Calculation Operation Calculator Tape
25+50=75 1-0
25 1-1 25
+ 50 1-2 + 50
= 1-T Total = 75
75-25=50 1-0
75 1-3 75
- 25 1-1 - 25
= 1-T  Total = 50
25+50-30=45 1-0
25 1-1 25
+ 50 1-2 + 50
- 30 1-3 - 30
= 1-T Total = 45
2x3=6 1-0
2 1-1 2
x 3 1-2 x 3
= 1-T  Total = 6
6+3=2 1-0
6 1-1 6
+ 3 1-2 + 3
= 1-T Total = 2
-2x3=-6 1-0
2 +/- 1-4 2
x 3 1-1 x 3
= 1-T Total = 6
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(2x3)+4=10 1-0
2 1-1 2
x 3 1-2 x 3
+ 4 1-3 + 4
= 1-T Total = 10
500x10%=25000 1-0
500 1-1 500
x 10% 1-2 x 10%
1-T Total = 25000
Memory Calculation Operation Calculator Tape
100+200=300 1-0
+ 400+500=900 100 1-1 100
1200 + 200 1-1 + 200
= 1-T Total = 300
MS
20
400 21 400
+ 500 2-2 + 500
= 2-T Total = 900
+ 3-0
MR 3-1 900
= 3-2 + 300
3-T Total = 1200
400+500=900 1-0
- 100+200=300 400 1-2 400 +
600 + 500 1-3 500 +
= 1-T Total 900 *
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MS
2-0
100 21
+ 200 2-2
= 2-T Total
M-
MR
3-0
3-1
+ 0 3-2
= 3-T Total
MC

100

+ 200

= 300

600

600

Adding a Sticky Note

Sticky Note

Use the Sticky Note tool to add any additional notes and comments needed. To add a sticky note, do

the following:

1. Click the Sticky Note tool on the PDFlyer tools. The Sticky Note automatically displays on the
top left corner of the active page. Drag the note to place it in a different location.

2. Double-click the sticky note to enter notes and comments. To change the background color, text
color, text size, or text style, select Sticky Note from the Settings tool. See Configuring

Settings on the next page for additional information.

Setting Status

0 Set Status

Use Set Status to track the status of bookmarks and pages by colorizing the bookmark and placing a
colored border around the selected pages. A status stamp is also placed on the top left corner of the

selected pages.
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PDFlyer stores your last used Status settings selected in the Set Status from the Settings tool. When
you click the Set Status tool, PDFlyer automatically re-uses the previously selected settings. Clicking
the tool is a quick way to apply a status to multiple bookmarks.

Resetting Status
4

'ﬁ
Reset Status

Use this tool to quickly remove a previously applied status color.

Note: If you selected Status Stamp on Set Status from the Settings tool, it is not removed. Select
the Status Stamp and press Delete to remove it.

Using Note Summary
2

Note Summary

Note Summary shows a complete list of all the notes and calculator tapes that are added in the PDF
file. Click the Note Summary tool from the PDFlyer tools to display the Note Summary window. The
list shows the content, page, and the author of the notes and calculator tapes in the PDF file. You can
click on each note and calculator tape to navigate to the page where the selected note or calculator
tape is located.

Using AutoFlow Summary

AutoFlow Summary

AutoFlow Summary shows AutoFlow details of the PDF file. Click the AutoFlow Summary tool in the
PDFlyer tools to display the AutoFlow Summary window. The summary shows who and when the
AutoFlow process is completed on the PDF file. It also shows other client data details, such as Client
ID, Client Name, Return ID, and Office Group.

Configuring Settings

Settings

Use the Settings tool in the PDFlyer tools to set or change the default PDFlyer settings for your
workstation. Click the Settings tools to display the Settings window.
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Bookmarks

Set the bookmark options on the Bookmarks tab. The options you can edit are:

= Colorize bookmarks when opening a PDF. Select this option to automatically colorize the
bookmarks when a PDF file is opened.
= Expand all bookmarks when opening a PDF. Select this option to automatically expand all
bookmarks when a bookmarked PDF file is opened.
* Hide empty bookmarks when opening a PDF. Select this option to automatically hide
empty parent bookmarks when a PDF file is opened.
= Show Bookmarks Pane when opening a PDF. This option is selected by default. If the PDF
file contains bookmarks, the bookmarks pane opens automatically. If you do not want to open
the bookmarks pane when opening a PDF, clear this box.
= Activate Bookmark Move function. Moving bookmarks automatically repaginates the PDF
file after moving bookmarks. Activate bookmark move function is selected by default. If you do
not want to repaginate the PDF file, clear this box. To move a bookmark and its corresponding
pages, do the following:
a. Verify that Activate Bookmark Move function is selected.
b. Click the bookmark to move and drag it to the new location. A dotted line displays to
indicate where the bookmark will be inserted.

c. Release the mouse button when you have the line icon in the desired location.
d. Click the bookmark to confirm that the pages were relocated correctly.

#= Colorize Bookmarks. Colorizing bookmarks gives you a quick way to determine which parent
bookmarks are populated or unpopulated and to distinguish the different levels of bookmarks
from one another. Click inside the Empty Bookmarks and Non-empty Bookmarks square to
display the Select Color window. Select a color or create a custom color, and then click OK.

Calculator

Set the calculator tape options on the Calculator tab. The options you can edit are:

= Text Color. Select a text color to display on the calculator tape by clicking inside the Text Color
square to display the Select Color window. Select a color or create a custom color, and then click
OK.

#= Tape Color. Select a background color for the calculator tape by clicking inside the Tape Color
square to display the Select Color window. Select a color or create a custom color, and then click
OK.

#= Text Size. Select a font size to display on the calculator tape.

s Export Section Column to PDF. The section column identifies the section and row of each
item on the calculator tape. This column prints to PDF by default. If you do not want to print the
Section column to PDF, clear this box.
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= Export Section Title Row to PDF. The section title row (i.e., 1-0) provides a space to enter a
title or description for each section. This row prints to PDF by default. If you did not enter a title
or description on the title row and do not want to print the Section Title row, clear this box.

= Active Calculator. Select which calculator to display in PDFlyer Tools. Both the Basic
Calculator and PDFlyer 10-key Calculator are selected by default. If you do not want to display
either one of them, clear the appropriate box.

Note: Selections made on these options apply to both the basic and 10-key calculators.

Insert PDF
Set the Insert PDF option on the Insert PDF tab.

Display option to delete file after inserting pages. When inserting pages in PDFlyer, you can
select to merge or append the incoming PDF file. You are prompted to delete the incoming PDF file
once it has been inserted. Click Yes to delete the inserted PDF file. Otherwise, click No. This box is
checked by default. If you do not want to receive the prompt and want to keep the inserted PDF file,
clear this box.

Set Status

Set the status options on the Set Status tab. The Set Status tab tracks the status of bookmarks,
pages, and status stamps by colorizing the bookmark, placing a colored border around the related
pages, and placing a status stamp on the related pages.

= What status color would you like to use? Click inside the Status Color square to display the
Select Color window. Select a color or create a custom color, and then click OK.

= What would you like the status to apply to? Select how to use the status color in this PDF.
= Bookmark. Check this option to set the status color on selected bookmarks.

= Bookmark Style. Select the style of the bookmark text. This option is only
available if Bookmark is selected.

= Page Border. Check this option to set the status color on selected pages. A colored
border displays around the pages.

= Width. Select the width of the border. The default width is 4. This option is only
available if Page Border is selected.

= Status Stamp. Check this option to apply a status stamp to selected pages.

= Text. Enter the text to display on the status stamp. If no text is entered, Status
displays by default.

« Date/Time. Clear this box if you do not want the date and time to display in the
status stamp. This box is checked by default.
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Stamps

Set the stamp colors and favorites on the Stamps tab. The options you can edit are:

Sticky Note

Set the sticky note options on the Sticky Note tab. The options you can edit are:

User Stamps

Stamp Colors. Stamp colors allows you to add and remove the colors of your stamps. Click
Add Color to select a color or create a custom color. If you no longer want to use a certain
color, highlight the color to remove then click Remove Color.

Stamp Size. You can make the connector and tickmark stamps larger or smaller. Select the
size that you want the stamps to display. All PDFlyer stamps change to the selected size.

Favorites. Create a set of favorite stamps by checking the check box next to each stamp that
should display on the tool. Once checked, these stamps appear in the Favorites drop-down list
on the PDFlyer Stamps tools. The first stamp checked as favorite is used as the icon for
Favaorites tool on the PDFlyer Stamps tools.

Text Color. Select a text color to display on the sticky note by clicking inside the Text Color
square to display the Select Color window. Select a color or create a custom color, and then click
OK.

Background Color. Select a background color for the sticky note by clicking inside the
Background Color square to display the Select Color window. Select a color or create a custom
color, and then click OK.

Text Size. Select the font size to display on the sticky note.

Text Style. Select the style of the text on the sticky note. The options are Normal and Italic.
The default is Normal.

Text Weight. Select the weight of the text on the sticky note. The options are Normal and Bold.
The default is Normal.

Create your own stamps on the User Stamps tab. Once created, User Stamps can be used like any
other PDFlyer Stamps. To create a User Stamp, do the following:

1.

Click Add to display the Add Stamp window.

Browse to locate the image you would like to use as a stamp.

Select the image and click Open. The image is now added in the User Stamps list. The name of
the image is used as the User Stamp name by default. To change the name of the User Stamp,

select the User Stamp and click Rename. You can also double-click on the User Stamp to
rename it.

To delete a User Stamp, select the User Stamp you want to delete and click Remove.

You can also resize your User Stamp by clicking Resize and entering the new size in the Size column.
The default size is 16 which is used for all PDFlyer stamps.
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You can export orimport User Stamps so you can share them with others in your office.
To export User Stamps, do the following:
1. Click Export to display the Export Stamps window.

2. Browse to the location where the file will be saved. All User Stamps are saved in one PDF file.

3. Enter the file name in the space provided and click Save.
To import User Stamps, do the following:

1. Click Import to display the Import Stamps window.
2. Browse to a valid PDF file for import. A valid PDF file is a PDF exported from PDFlyer Stamps.
3. Click Open.

PDFlyer Stamps Tools
(%

" Keep Stamp Selected

PDFlyer provides a set of stamps in the form of connectors and tickmarks. Click the Keep Stamp
Selected tool to use the same stamp multiple times.

To use the same stamp several times in a row, do the following:
Select the stamp you want to use from the PDFlyer Stamps tool.

Click the Keep Stamp Selected tool. When selected, the tool is highlighted in gray.
Use the stamp as needed in the document.

> wbd =

To turn off this feature, click the Keep Stamp Selected tool again. The highlight is removed.

Note: To move a stamp to a different location on the page while Keep Stamp Selected is
enabled, press the Ctrl key while dragging the stamp to the desired location.

- i
I'-'--‘!-(" Stamp Color

Click the Stamp Color tool and select the color you would like to use. When the color is changed, all
stamps dynamically change to the selected color. You can add and remove colors by selecting
Manage Stamp Color from the Stamp Color tool.
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Creating User Stamps

e User Stamps

PDFlyer allows you to create your own User Stamps, which can be used like any other PDFlyer
Stamps. To create a User Stamp, do the following:

1. Select the User Stamp Settings from the User Stamps tool to display the Settings window. The
User Stamps is selected by default.

2. Click Add to display the Add Stamp window.

3. Browse to locate the image you would like to use as a stamp.

Select the image and click Open. The image is added to the User Stamps list. The name of the
image is used as the User Stamp name by default. To change the name of the User Stamp,
select the stamp and click Rename. You can also double-click a User Stamp to rename it.

To delete a User Stamp, select the User Stamp you want to delete and click Remove.

You can resize your User Stamp by clicking Resize and entering the new size in the Size column. The
default size is 16, which is used for all PDFlyer stamps.

You can export/import User Stamps so you can share them with others in your office.
To export User Stamps, do the following:
1. Click Export to display the Export Stamps window.

2. Browse to the location where the file will be saved. All User Stamps are saved in one PDF file.

3. Enter the file name in the space provided and click Save.
To import User Stamps, do the following:

1. Click Import to display the Import Stamps window.
2. Browse to a valid PDF file for import. A valid PDF file is a PDF exported from PDFlyer Stamps.
3. Click Open.
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Working with Connectors, Tickmarks, User Stamps, and Recent

Stamps
Tickmarks | i'{ Engagement

‘@ Connectors @ Letter Connectors

PDFlyer provides a set of stamps in the form of Numbered Connectors (1-50), Lettered Connectors
(A-Z2), Standard Tickmarks, Engagement Tickmarks, Favorites, Recent Stamps, and User Stamps.
The stamps, together with Keep Stamp Selected, Stamp Color, and Stamp Summary display on the
PDFlyer Stamps tools.

(2]

Bl

To choose a connector, tickmark, or user stamp, select the desired item from the list. Your selection
remains the default connector, tickmark, or user stamp until another one is chosen. The currently
selected connector, tickmark, or user stamp is indicated in the PDFlyer Stamps tools.

Connectors link information in the PDF. For example, if a line amount is related to another line
amount, connectors can be used to link the amounts together. Numbered and lettered connectors are
available.

All stamps are also hyperlinks. If you use stamps on multiple pages, right-click the stamp and select
from the menu to move back and forth between the related pages.

To use the hyperlink functionality to navigate between connected data in a PDF file, do the following:

Select the connector or tickmark stamp in the PDF.
2. Right-click to display the shortcut menu.

Use the navigation options (Go to Previous, Go to Next, All other pages with stamp, and All
pages without stamp) to see and jump to pages associated with this stamp. By placing a specific
stamp on each page, you can use these options to track your progress in the document. Use the
navigation options as a way of tracking what has been done and what still needs to be done.

Status Stamps and User Stamps are independent of the PDFlyer Stamps.

#  On the right-click menu, a Status Stamp displays with the word Status before the stamp name.

® On the right-click menu, a User Stamp displays the word User Stamps before the stamp name.
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Standard Tickmarks and Engagement Tickmarks are used as an information note. These shorthand
symbols show that an amount has been checked, footed, etc. Each tickmark has its own symbol.

Tickmarks

= Approximate

(£) Calculated

CF Carry Forward

+  Checkmark

(' Confirmed

crm Confirmed with exception

e Confirmed with exception cleared
' Consistent & Comparable with Prior Year
L7 Cross-footed

ft Cross Reference

our Duplicate Info

YV Examined WVoucher

7 Footed

Gl General Ledger

¢t Immaterial

MR Mo Reply

4

. Mo Tax Effect
A Mot Applicable

'l
=

- Prepared by Client
FY Prior Year

K Recomputed-Werified
() Recalculated

W Review

e Reviewed

¥ Summation

1% Superseded

A Tickmark

I'k Used on Tax Return
D Unreconciled Difference

wre Working Trial Balance

Engagement

« Agreesto

GL Agrees to General Ledger

PY Agrees to Prior Year

() Calculated

C Confirmed

& Confirmed with exception

¢ Confirmed with exception cleared
& Consistent & Comparable with Prior Year
= Cross-footed

IT Footed

{ Immaterial

NR Mo Reply

++ Recalculated

UD Unreconciled Difference

Recently used stamps appears in the Recent Stamps list on the PDFlyer Stamps tools. This allows
users to easily access the stamps that have recently been used. To clear this list, select Clear
Recent Stamps.
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Using Stamp Summary

Stamp Summary

Stamp Summary shows a complete list of all the stamps that are used in the PDF file. Click the
Stamp Summary tool in the PDFlyer Stamps tools to display the Stamp Summary window. The
summary can be exported to a .txt file by clicking on the Export button. Details, such as the pages the
stamps are used on, the date and time the stamps are used, and the person who used the stamps,
display when you click Expand All. When details are expanded, you can click on each listed page to
navigate to the page where the selected stamp is located. To hide the details, click Collapse All.
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Appendix

SETTINGS AND TIPS

Scanner Settings

Use the following scanner settings to achieve the best results with Scan.

Setting Recommended Notes
Resolution ?»00 dot§ per T‘hIS. s‘ett.lng provides a high-quality image without
inch (dpi) diminishing system performance.

CCITT Group 4 . . . . .
Using this compression setting maximizes

Compression Fax or Fax , i o
performance while also managing the file size.
Group 4
Documents that are not fed into the scanner
. Letter or Legal ]
Page size Size correctly can create larger images that may

cause errors. Forcing page size prevents this.

TIF images are high quality and easier to
troubleshoot than some other types of files.
TIF (not PDF) Note: Do not save scanned images as PDF files.

Scan cannot process PDF files generated by other
programs.

File format of file output
from the scanner

Advanced settings
If enabled, these settings may cause the scanner

to attempt to fill in missing pixels, which can blur
text and negatively affect text recognition.

* Enhanced image Disabled
* Dithering
® |nterpolated

Do not use the grayscale setting, which
Image color Black and white  introduces additional pixels into the image that
can negatively affect the accuracy of the data
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Setting Recommended Notes

extraction.

This setting will fill every blank space (such as a
Fill with Black setting Disabled hole punch) with black, which can negatively
affect recognition.

E Note: If your scanner creates separate documents for each page when scanning, we suggest you
scan documents into an intermediary folder. Then, you can move files to an Import folder. If you
scan directly into an Import folder, Scan processes each page separately and creates single-page
PDF files in the Export folder.

Scanning Tips

Use the following tips to optimize your results with Scan's optical character recognition (OCR)
capabilities.

®* Check originals for legibility. If they are very light, photocopy them with higher contrast.

* When possible, scan original documents instead of faxes or photocopies. Image quality
degrades every time a document is duplicated.

# Prepare your documents for scanning by:

®* Removing staples and fanning out pages.

* Unfolding pages and bent corners.

®* Moving or removing sticky notes so they do not cover pertinent data. You can attach
them to a blank sheet of paper and include a reference to the original page. To prevent
notes from being misplaced,tape them down or place the sheets in a scanning sleeve.

* Placing small, odd-sized, or delicate pages in a scanning sleeve. Also known as
document carriers, these can be found at a variety of retailers and are re-usable.

* |f a source document is a TIF file, print the cover page and target sheet to TIF files, and then
insert them into the client's source TIF file. You can then copy the client's updated TIF file into
the Import folder, where Scan Administrator will pick up the job for processing.

*# When possible, do not use ledger paper for documents you plan to scan. Ledger paper adds a
large number of pixels, causing a slowdown in processing and OCR errors.

* To prevent jamming, run dog-eared or staple-damaged documents through the scanner bottom
first.

® Clean your scanner regularly to prevent excessive speckling of your scanned documents.

®* Check the scanned files before submitting them for Scan processing. If any of the following
occur in your image file, they can cause errors in the OCR processing:

= Vertical lines are generally caused by a spot or object on the scanner's imager. If this is
the cause, the line will appear in the same location on multiple pages.
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= Horizontal lines are usually caused by document feed issues, such as the rollers not
functioning properly, an inconsistent vacuum feed, or a sticky page (the edge of a label
or sticky note causing the document to stop).

= Specks, dots, and recurring spots are often caused by dirt, ink, or torn corners from
pages being left in the scanner, on the scan bay, or on the imager.
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